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New Features

The following features have been added in this release of TIBCO ActiveMatrix® Service Grid.

Log4j 2.17.x Upgrade

Starting with the TIBCO ActiveMatrix® Service Grid 3.4.2, the log4j 1.x is upgraded to log4j
2.17.x.

Limitations with Log4j 2.17.x upgrade

e Commonlogging/LogService is deprecated, JMS Appender and CBE XML file appender
are not supported. Clear Text File Appender is supported.

» Old API's of log4j and sl4j are not accessible. BPM Applications and Customer
Applications if using those API's needs to be reconfigured.

e Change in the package of classes within log4j and slf4j libraries, which require to
change all over the place where those classes have been used.

* A new log configuration format is required to be used, so naming conventions of
parameters needs to be handled according to the new format. Example, maxFileSize,
maxBackuplndex parameters in the file appender now changed to
SizeBasedTriggeringPolicy, DefaultRolloverStrategy.

Supported JDBC Driver Versions
Following JDBC driver versions are supported in TIBCO ActiveMatrix® Service Grid 3.4.2:

e TIBCO enabled JDBC driver for Microsoft SQL Server 11.2.3
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o Note: To configure the third-party driver mssql-jdbc-11.2.3.jar for
Microsoft SQL Server 2019 or any backwards compatible Microsoft SQL
Server database, you must add trustServerCertificate=true in the JDBC

URL.

Example JDBC URL: jdbc:sqlserver://test-
localhost:1433;DatabaseName=dbname;trustServerCertificate=true

When you download the Microsoft JDBC Driver for SQL Server (version
11.2.3), the default JAR name is mssql-jdbc-11.2.3.jre8, but when
configuring the third-party driver by using TCT, you must rename mssql-
jdbc-11.2.3.jre8.jar to mssql-jdbc-11.2.3.jar.

e TIBCO enabled JDBC driver for PostgreSQL 14.4.0

e TIBCO enabled JDBC driver for IBM DB2 4.32.28

o Note: Support for the TIBCO enabled JDBC driver for IBM DB2 4.32.28 is
added in TIBCO ActiveMatrix® Service Grid 3.4.2 but it is not visible in the
TCT Third-party Driver Configuration Wizard List.

To configure this driver, follow the steps mentioned below.

1.
2.
3.

Open a Third-party Driver Configuration Wizard from TCT.
Select TIBCO enabled JDBC driver for IBM DB2 4.24.92 Driver

Download the latest JDBC Third-Party Driver Jar of DB2 11.5.x (Jar
name: db2jcc4.jar and Version: 4.32.28)

Give the path of the db2jcc4.jar folder in TCT and Configure.

Java 11.0.20 Support for TIBCO ActiveMatrix Runtime and TIBCO

Business Studio

Starting with the TIBCO ActiveMatrix® Service Grid 3.4.2, Java 11.0.20 is supported for both
the TIBCO ActiveMatrix Runtime and TIBCO Business Studio™ - BPM Edition.
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TLSv1.3 is Supported

Starting with the TIBCO ActiveMatrix® Service Grid 3.4.2, TLSv 1.3 is supported. Please see
for more information.

o Note: TLSv1.3 is not backward compatible. Please see this for more information.

TIBCO ActiveMatrix Administrator Server by default uses TLSv 1.2 for SSL connection. To
update protocol TLSv, follow the steps mentioned below

1.
2.

Secure any host from Ul.
Go to <TIBCO_HOME>/amx/3.4/bin folder and run the following command:

"tibamx_hostmanager updateAdminToTLSv13 -configHomeLocation <TIBCO_CONFIG_
HOME>"

Go to <CONFIG_HOME>\tibcohost\Admin-amxadmin-instanceOne\data_
3.2.x\host\plugins and edit ri_tibco.admin.default.ssl.server_SystemNode_1.0_
1686560749194.jar with changing ssl protocol TLSv from 1.2 to 1.3

Save the file and restart the admin.

o Note: Refer AMX-19068 and AMX-17498 for the known and close issues.
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Changes in Functionality

No functionality changes have been made in this release of TIBCO ActiveMatrix® Service
Grid 3.4.2.
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Changes in Platform Support

Following platform support have been added in this release of TIBCO ActiveMatrix® Service
Grid 3.4.2.

e Microsoft Windows Server 2022

Windows 11

Oracle Linux 8.x and 9.x

RHEL 9.x

SUSE 15 SP3
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Deprecated Features

The following features have been deprecated in this release of TIBCO ActiveMatrix® Service
Grid 3.4.2.

Affected Description Deprecated in
Component Version
Java 8 Any existing application using JDK 8 must be  3.4.2

upgraded to JDK 11.

SVN Toolkit SVN Toolkit is deprecated in the 3.4.2 3.4.2
release.
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Removed Features

The following features have been removed in this release of TIBCO ActiveMatrix® Service
Grid 3.4.2.

Affected Component Description Deprecated in Removed in
Version Version
Log Service and Log service and payload service  3.4.1 3.4.2
Payload Service are removed.
TIBCO ActiveMatrix® ActiveMatrix® Service 34.1 3.4.2
Service Performance Performance Manager is
Manager deprecated in this release.
Database Oracle Database 12c¢, 12c RAC, 3.4.1 3.4.2
12.1.x, 12.2.x.
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Migration and Compatibility

The following information provides migration procedures and a compatibility matrix for
this release of TIBCO ActiveMatrix® Service Grid 3.4.2.

Product Compatibility

ActiveMatrix Service Grid 3.4.2 adds compatibility support for the following TIBCO product
versions:

e TIBCO Enterprise Message Service™ 10.2.1
e TIBCO® Operational Intelligence Hawk® RedTail 7.2.2

For a complete list of compatible products and versions, see the Readme file.
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Closed Issues

The following issues have been closed since the last major release of TIBCO ActiveMatrix®
Service Grid 3.4.2.

Key Summary

AMRP-5788 Previously, the user could not append (merge) new JVM arguments to the
existing JVM arguments for a Node using the command line.

With this fix, the user can append (merge) new JVM arguments to the existing
JVM arguments for a Node using the 'update’ build target of node_build.xml
with a task attribute 'options="mergeJvmArgs".

AMRP-5804 Previously, in the AMX Admin GUI, there was no field to specify "max pool
size" for the Kerberos Authentication Resource Template. Along with that, in
the command-line scripts (AMX XML schemas for build data file
'resourcetemplate_data.xml') there was no 'max pool size' for Kerberos
Authentication.

With this fix, users can specify "max pool size" for the Kerberos
Authentication Resource Template in the Admin GUI and command-line
scripts. If not provided, the default value is "20".

Below is the command-line script sample:

<ResourceTemplate
xsi:type="amxdata:KerberosAspResourceTemplate"
name="kerberosAspRT">

<GeneralConfiguration xsi:type="amxdata:Kerberos_
ResourceTemplate_General"

Description="This is kerberosAsp RT generalConfiguration"
maxPoolSize="20"

KerberosRealm="KerberosRealm"
KeyDistributionCenter="KeyDistributionCenter"/>

</ResourceTemplate>
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Key

AMRP-5790

AMRP-5791,
AMRP-5765

AMRP-5792

AMRP-
5787,TAP-
16588, TAP-
16586, TAP-
16579

Summary

When the 'Timeout' property of an SMTP shared resource has been
configured, but the target email server does not respond with code 220
("SMTP Service Ready"). This causes the thread calling the SMTP shared
resource to wait forever.

With this fix, the timeout value for the SMTP shared resources work as
expected.

Stopping one WebApp component stops the Node JVM property
"allowed.referers" for other WebApp components that run on the same node.

With this fix, this does not happen.

To specify the "Pool Idle Timeout" attribute for LDAP Authentication shared
resources on a particular Node, add the following JVM property to the Node
tra file, and restart the Node.

java.property.com.sun.jndi.ldap.connect.pool.timeout=<value>
(timeout s in milliseconds)

For example,
java.property.com.sun.jndi.ldap.connect.pool.timeout=180000

A pooled LDAP Authentication connection is recycled after it has been idle for
the above specified timeout period.

Previously in the ActiveMatrix Admin GUI, there is no field to specify 'max
pool size' for the Kerberos Authentication Resource Template. Also in
command-line scripts (AMX XML schemas for building data file
'resourcetemplate_data.xml') there is no 'max pool size' for Kerberos
Authentication.

With this fix, users can specify 'max pool size' for the Kerberos Authentication
Resource Template in the Admin GUI and also in command-line scripts (AMX
XML schemas for build data file 'resourcetemplate_data.xml'). If not provided,
the default value is "20". Below is the command-line script sample:

<ResourceTemplate
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Key

AMRP-5760

AMRP-5764

AMRP-
5766/AMRP-
5786

Summary

xsi:type="amxdata:KerberosAspResourceTemplate"
name="kerberosAspRT">
<GeneralConfiguration xsi:type="amxdata:Kerberos_

ResourceTemplate_General"

Description="This 1is kerberosAsp RT
generalConfiguration"

maxPoolSize="20"
KerberosRealm="KerberosRealm"
KeyDistributionCenter="KeyDistributionCenter"/>

</ResourceTemplate>

To specify the "Pool Idle Timeout" attribute for LDAP Authentication shared
resources on a particular Node, add the following JVM property to the Node
tra file, and restart the Node.

java.property.com.sun.jndi.ldap.connect.pool.timeout=<value>
(timeout 1is in milliseconds)

For example, java.property.com.sun.jndi.ldap.connect.pool.timeout=180000

A pooled LDAP Authentication connection is recycled after it has been idle for
the above specified timeout period.

Previously, the user was not able to append (merge) new JVM arguments to
the existing JVM arguments for a Node using the command line.

With this fix, the user is able to append (merge) new JVM arguments to the
existing JVM arguments for a Node using the 'update’ build target of node_
build.xml with a task attribute 'options="mergeJvmArgs"'.

The target email server does not respond with code 220 ("SMTP Service
Ready"), even if the 'Timeout' property of an SMTP shared resource has been
configured, the timeout does not happen, and consequently the thread
calling this SMTP shared resource waits forever.

With this fix, the timeout value for the SMTP shared resources work as
expected.
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Key

AMX-18722

AMX-18771

AMX-18723

AMX-18772

Summary

Previously in AMX 3.4.1, the TCS Server used TLS v1 as the default security
protocol. When lower TLS versions (1.0, 1.1) were disabled by users, SSL
handshakes with the TCS Server would fail as the protocols do not match.

With this fix, the TCS Server uses the higher version TLS as default for secure
connections, and it supports the lower TLS versions as well. Even if lower
versions of TLS (1.0, 1.1) are disabled by the user, there is no handshake
errors with the TCS server.

Previously, if the name of an application bundle archive under the Node work
cf folder is not of the default or original form "bundle", then the AMX 3.4.1
Platform upgrade may fail.

With this fix, even if an application bundle archive has a non-default name
such as "bundle2", "bundle3", etc., the AMX 3.4.1 Platform upgrade does not
fail.

Previously When accessing the SOAP/JMS operation from BW, the UserName
Authentication was failing after the SSO login.

With this fix, users are able to enable dual Authentication mode for
UserName Token and SAML WebProfile SSO Authentication. When accessing
the SOAP/JMS operation from BW, the UserName Authentication with SSO
login works fine as expected.

Assume that in a BPM environment (version 4.3.1 or previous) there is a
ProcessFlow application that has a dependency on a BDS application v1.
When the BDS application is upgraded from v1 to v2, the v1 changes to PFU,
and v2 is in running state, and by our BPM product design, the ProcessFlow
application still has its dependency on v1 of the BDS application.

After upgrading the AMX platform to 3.4.1, the amx.bpm.app should be
stopped by our upgrade scripts - but for some reason this does not happen.
So amx.bpm.app is in a partially running state. Under this circumstance, it
makes the wrong decision that the v1 version of the BDS application should
be removed. Consequently v1 is removed in BPM 4.3.2 upgrade, which leads
to the child ProcessFlow app bundle 'does not resolve' and thus the app
'START_FAILED".
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Key

AMX-18948

AMX-18859

Summary

With this fix, the amx.bpm.app is in the expected "Stopped" rather than the
"Partially Running" state before the AMX platform upgrade happens. This
prevents previous version BDS applications from being removed incorrectly.

Previously, when trying to provision an IBM MQ 7.x driver on AMX 3.4.1
Nodes, it fails with an error of Import-Package: javax.jms. With this fix, the
IBM MQ 7.x driver can be successfully provisioned on AMX 3.4.1 Nodes.

Previously, the HTTP Client would not close the TCP connection and the pool
'Idle Timeout' setting does not work as expected when connection pooling is
enabled. Added support for the 'Idle timeout' field on the Advanced
configuration tab of HTTP Client RT.

HTTP Client closes the TCP connection when connection pooling is enabled
based on the Idle Timeout value. The Idle Timeout is specified in the xxx
time unit. The default value is "-1" which means 'Never timeout'.

Previously in the admin GUI, there is an 'ldle timeout' field that comes under
the General configuration tab that is now renamed to 'Linger Timeout'.

Below is the command-line script sample:

<ResourceTemplate
xsi:type="amxdata:HttpClientResourceTemplate"
name="HttpclientRT"
isAcceptRedirect="true"
connectionTimeout="8888"
host="test-host"
port="80"
description="This is HttpClient RT"
ss1INDIName="JdbcNonXaTx_Identity"
idleTimeout="-1">
<AdvancedConfiguration
xsi:type="amxdata:HttpClientResourceTemplate_
Advanced"
localSocketAddress="1localhost">
<EnableConnectionPooling
xsi:type="amxdata:EnableConnectionPooling"
maximumTotalConnections="5"
maximumTotalConnectionsPerHost="10"/>
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Key

AMX-18281

AMX-18322

AMX-17860

AMX-18629

Summary

</AdvancedConfiguration>
</ResourceTemplate>

Previously, when accessing the SOAP/JMS operation from BW, the UserName
Authentication was failing after the SSO login.

With this fix, the users are able to enable dual Authentication mode for
UserName Token and SAML WebProfile SSO Authentication. When accessing
the SOAP/JMS operation from BW, the UserName Authentication with SSO
login works fine as expected.

Previously in AMX 3.4.0, the TCS Server used TLS v1 as the default security
protocol. When lower TLS versions (1.0, 1.1) were disabled by users, SSL
handshakes with the TCS Server would fail as the protocols do not match.

With this fix, the TCS Server uses the higher version TLS as default for secure
connections, and it supports the lower TLS versions as well. Even if lower
versions TLS (1.0, 1.1) is disabled by the user, there is handshake errors with
the TCS server.

Previously, the user was not able to perform JDBC Test Connection for JDBC
XA RT type.

With this fix, the user can perform JDBC Test Connection for JDBC XA RT
type.

Note: If the CLI attribute "disableValidateConnectionOnlnit" is "true" in the
JDBC Resource Template build data file, or the SystemNode TRA property
"java.property.com.tibco.admin.jdbc.disable.validate.connection.oninit" is
"true" while creating JDBC RT then JDBC Test Connection is not called and RI
installation is successful.

Previously, when running Enterprise Deployment Health Check it fails with
errors like below:
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Key

AMX-18661

Summary

"Failed to parse machineUsedPhysicalMemorySize: 8,1 GB"

With this fix, now ","(comma) is also a supported decimal separator and we
are not seeing this error now.

Note: Decimal separators (symbols) have region (country)-specific formats,
and can be configured at OS level Regional Settings.

The HTTP Client does not close TCP connection and the 'Pool Idle Timeout'
setting does not work as expected when connection pooling is enabled.

Added support for the 'ldle timeout' field on the Advanced configuration tab
of HTTP Client RT. HTTP Client closes TCP connection when connection
pooling is enabled based on the Idle Timeout value. The Idle Timeout is
specified in xxx time unit. The default value is "-1" which means 'Never
timeout'.

Note: Previously, in the admin GUI there is an 'ldle timeout' field that comes
under the General configuration tab that is now renamed to 'Linger Timeout'.

Below is the command line script sample:

<ResourceTemplate
xsi:type="amxdata:HttpClientResourceTemplate"
name="HttpclientRT"
isAcceptRedirect="true"
connectionTimeout="8888"
host="test-host"
port="80"
description="This is HttpClient RT"
ss1TINDIName="JdbcNonXaTx_Identity"
idleTimeout="-1">
<AdvancedConfiguration
xsi:type="amxdata:HttpClientResourceTemplate_
Advanced"
localSocketAddress="1localhost">
<EnableConnectionPooling
xsi:type="amxdata:EnableConnectionPooling"
maximumTotalConnections="5"
maximumTotalConnectionsPerHost="10"/>
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Key Summary

</AdvancedConfiguration>
</ResourceTemplate>

AMX-17498 In an ActiveMatrix setup when secure SystemHost and RemoteHosts (host for
which the JMX port is secured) were successfully upgraded to ActiveMatrix
Service Grid 3.4.0, the Administrator Ul did not show the updated Hosts'
versions correctly. This is because when the hosts are secured, SystemNode
is configured with TLSv1, which is the supported TLS in versions of
ActiveMatrix prior to 3.4.0. Starting TIBCO ActiveMatrix 3.4.0 TLSv1.2 is
supported, and all the Hosts are updated to automatically use TLSv1.2 when
upgraded to 3.4.0, except the Administrator (SystemNode).

When you encounter this issue, please run the following command after
applying TIBCO ActiveMatrix 3.4.0 Hotfix 001, or upgrading directly to TIBCO
ActiveMatrix 3.4.0 Hotfix 001, to update the Administrator (SystemNode) to
support TLSv1.2. Go to <TIBCO_HOME>/amx/3.4/bin folder and run the
following command:

tibamx_hostmanager updateAdminToTLSv12 -configHomelLocation
<TIBCO_CONFIG_HOME>

NOTE: Hosts and nodes must be stopped before running the above
command. After running the command, restart the Administrator
(SystemNode). The above command must be run only on the machine where
SystemNode is running.

SDS-7796 When an application with a SSL-enabled HTTP connector tries to connect to
a deployment server, the connection fails.

Now for the SSL enabled HTTP connector, a connection gets established.
TAP-16601 Previously, setting the node JVM property with a value containing the special
character '(' (left parenthesis) causes the node to be "Out of Sync" and stuck

in an "Install failed" state. With this enhancement, the special character "("
(left parenthesis) is supported in Node tra.
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Key

TAP-16602

TAP-16619

TAP-16620

TAP-16406

Summary

Previously, the special character % (percent symbol) was not supported to be
part of a JUM property value in the Node tra file. With this enhancement, the
special character "%" (percent symbol) is supported in the Node tra file.

When trying to create/update a substitution variable from the Admin Ul with
a value containing a special character """ (single quote), and when saving the
changes, the Admin Ul generates the following error:

"There are one or more errors 1in Substitution Variables" "User
Input for Local Value is invalid! It contains an dinvalid
character: '.' "

With this fix, users are able to add/update SVar that has special characters
(single quotes) via the admin UL.

Previously, the ActiveMatrix Administrator was not able to handle special
characters in the TaskResult table, and consequently did not display the
application's State and Synchronization correctly, and components status
were partially missing for some nodes. In the Node log there were errors like
below:

java.lang.NumberFormatException: For input string: " "

With this fix, the special characters are filtered out when storing data in the
TaskResult table, the Administrator can display the state of an application
and its components properly.

When trying to create/update a substitution variable from the Admin Ul with
a value containing a special character """ (single quote), and when saving the
changes, the Admin Ul generates the following error:

"There are one or more errors in Substitution Variables"
"User Input for Local Value
is dnvalid!. It contains an 1invalid character: '''."

With this fix, users are able to add/update SVar that has special characters """
(single quotes) via the admin UL.
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Key

TAP-16621

TAP-16622

TAP-16623

TAP-16662

Summary

Previously, the 'updateJDBCDriver' AMX Administrator CLI action was used to
update JDBC drivers of all nodes under the enterprise in a single AMX
Administrator backend action. Due to this, DB concurrency issue was seen
most of the time.

With the fix, the action 'updateJDBCDriver' AMX Administrator CLI action is
done for 5 nodes at a time under a given entity
(Host/Environment/Enterprise).

When a user tries to run the 'updateJDBCDriver' CLI target to upgrade the
JDBC driver for all nodes of a very large AMX setup, the command-line script
failed with an error like below:

ERROR - SQL State[42000], Error code[1,795], Message[ORA-
01795: maximum number of expressions in a list is 1000

With this fix, the above SQL error is no longer seen and the
updateJDBCDriver command-line script runs successfully.

Previously, before each build target within a CLI command was actually run,
the AMX Admin Server and Enterprise state would be checked and the
summaries were generated. For a large AMX 3.4 setup (for example, hundreds
or even thousands of nodes), fetching such information would take a long
time.

With this fix, a cache mechanism is introduced, which significantly reduces
the unnecessary Admin Server and Enterprise queries, and thus improves
user experience.

Previously, it was possible to set 'max pool size' for SiteMinder shared
resource using a CLI approach, there was no GUI approach to do the same (in
the AMX Admin GUI there was no field 'max pool size' for SiteMinder
Resource Template). Having a CLI but no GUI approach causes some troubles
such as being not easy/straightforward to inspect or view the currently
specified max pool size for a particular SiteMinder shared resource, and
special attention/care needs to be taken to avoid incorrectly overwriting any
existing configurations each time you try to update some configuration(s) of
a SiteMinder shared resource.
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Key

TAP-16665

TAP-16676

TAP-16381

TAP-16573

Summary

With this fix, users can specify and view 'max pool size' for the SiteMinder
Resource Template connection pool from the Admin GUI. Also the SiteMinder
Resource Template configurations can be updated without worrying about
existing configurations being overwritten incorrectly. If not specified, it is set
to the default value "20" in both GUI or CLI.

Previously, when the node on the 'Node Health' column had an 'In progress'
state, sometimes hovering the mouse over the 'In progress' column did not
show the user the reason why it was in_progress.

With this fix, now if the nodes on the "Node Health" column has 'In progress'
state, then hovering the mouse over the 'In progress' column shows the exact
reason why the 'Node Health' column keeps on 'In progress' state.

The user was unable to create a substitution variable from the AMX Admin Ul,
whose value contains special characters <(less than), >(greater than), "
(Double quotes), '(single quotes).

With this fix, users can create a substitution variable from AMX Ul or CLI,
whose value contains special characters <(less than), >(greater than), "
(Double quotes), '(single quotes).

NOTE: There is one limitation - if a user wants to create a substitution
variable whose value contains the special character '<(less than)' through the
command line, then use '&lt;' instead of '<' in the command line build data
file.

Below is the command-line script sample <SVar xsi:type="amxdata_
base:SubstitutionVariable" name="enterprise-svarl" type="String" value='&lt;'
description="less than symbol"/>

Previously, during accessing Internal HTTP Connector in RT via Administrator
GUI getting exception as 'Mapping name not fond for the package:
org.hibernate.exception'. With this fix, during accessing the Internal HTTP
Connector in RT via the Administrator GUI, no exceptions are seen.

When the node on the 'Node Health' column had an 'In progress' state,

sometimes hovering the mouse over the 'In progress' column did not show
the reason why it was in progress.
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Key

TAP-16581

TAP-15963

TAP-16109

TAP-16370

TAP-16377

Summary

With this fix, if the nodes on the 'Node Health' column keep an 'In progress'
state, then hovering the mouse over the 'In progress' column shows the exact
reason.

Previously, when a user deletes application level loggers of an application
from the Admin Ul, the reference binding log4j.xml was not deleted and
consequently the corresponding log entries still get printed.

With this fix, application level logging is removed completely after application
level loggers are deleted from an application.

Previously, before each build target within a CLI command was actually run,
the AMX Admin Server and Enterprise state would be checked and the
summaries were generated. For a large AMX 3.4 setup (for example, hundreds
or even thousands of nodes), fetching such information would take a long
time.

With this fix, a cache mechanism is introduced, which significantly reduces
the unnecessary Admin Server and Enterprise queries, and thus improves
user experience.

When a user tries to run the "updateJDBCDriver" CLI target to upgrade the
JDBC driver for all nodes of a very large AMX setup, the command-line script
failed with an error like below:

ERROR - SQL State[42000], Error code[l1,795], Message[ORA-
01795: maximum number of
expressions in a list is 1000

With this fix, the above SQL error is no longer seen and the
updateJDBCDriver command-line script runs successfully.

Previously, the special character % (percent symbol) was not supported to be
part of a JVM property value in the Node tra file. With this enhancement, the

special character "%" (percent symbol) is supported in the Node tra file.

Previously, the 'updateJDBCDriver' AMX Administrator CLI action was used to
update JDBC drivers of all nodes under the enterprise in a single AMX
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Key Summary

Administrator backend action. Due to this DB concurrency issue was seen
most of the time.

With the fix, the action 'updateJDBCDriver' AMX Administrator CLI action is
done for 5 nodes at a time under a given entity
(Host/Environment/Enterprise).

TAP-16393 Previously, setting a node JVM property with a value containing the special
character '(' (left parenthesis) caused the node to be "Out of Sync" and stuck
in an "Install failed" state.

With this enhancement, the special character "(" (left parenthesis) is
supported in Node tra.

TAP-16402 Previously, the ActiveMatrix Administrator was not able to handle special
characters in the TaskResult table and consequently did not display the
application's State and Synchronization correctly, and components status
were partially missing for some nodes. In the Node log there were errors as
shown below:

java.lang.NumberFormatException: For input string: " "

With this fix, the special characters are filtered out when storing data in the
TaskResult table, the administrator can display the state of an application
and its components properly.
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Known Issues

The following issues exist in this release of TIBCO ActiveMatrix® Service Grid.

Key
AMR

P-
5827

AMR

5826

AMR

Summary

Summary: On AMX 3.4.2, while executing the following scenario:
» Application: SOAP(HTTP) -> JAVA(XMLBeans)
» DataSize - 1K
* Node and application settings - default

It is observed that the below-blocked call time is increased and an error is observed
in node log in AMX 3.4.2 as compared to AMX 3.4.1.

71.1% - 103 s java.util.UUID.randomUUID blocked call time is
increased and an error is observed in node log

Workaround: None

Summary: On AMX 3.4.2, while executing the following scenario:
» Application: REST(JSON) » JAVA (Post method)
e DataSize - 1K
* Node and application settings - default

It is observed that the below-blocked call time is increased in AMX 3.4.2 as compared
to AMX 3.4.1.

94.3% - 287 s
org.eclipse.osgi.framework.internal.core.AbstractBundle.loadClass
blocked call time is increased.

Workaround: None

Summary: On AMX 3.4.2, while executing the following scenario:

TIBCO ActiveMatrix® Service Grid Release Notes



25 | Known Issues

Key

P-
5825

AMR

5824

AMR

5628

AMR

5445

Summary

» Application: SOAP(HTTP) -> JAVA(JAXB)
e DataSize - 1K
* Node and application settings - default

It is observed that the below-blocked call time is increased in AMX 3.4.2 as compared
to AMX 3.4.1.

40.1% - 264 s java.util.concurrent.ArrayBlockingQueue.poll
28.6% - 189 s java.util.concurrent.ArrayBlockingQueue.offer
18.3% - 120 s java.util.concurrent.ArrayBlockingQueue.take

Workaround: None

Summary: Load tests were executed with increasing concurrency and it is observed
that the memory utilization for the Policy Director scenario is higher compared to the
Default scenario in AMX3.4.2. Also for 5 users concurrency Out of memory is observed
for the default heap and 4 GB heap, while executing the following scenario:

e Application: SOAP(HTTP) -> JAVA(XMLBeans)[Basic Authentication]
e DataSize - 1K
» Node and application settings - default

Workaround: None

Summary: The node status does not include custom features during the sequential
checks when determining node health.

Workaround: None

Summary: If a Node Start action has been performed and the messaging bundle is
found to be in a Stopped state, the ActiveMatrix Administrator CLI stops responding
as the EMS messaging bundle is not loaded in the OSGi. This happens due to a
limitation in the ActiveMatrix platform.

Workaround: Re-install the Node as the Node is in a corrupt state.

Summary: The timeout value of a promoted service or a component service is not
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Key

AMR

5043

AMR

4754

AMR

4736

AMR
P-

Summary

updated when a promoted service or a component service is promoted.

Workaround: Specify the timeout value using the application-level property. For
example, if the name of an application is weatherApp, the following property can be
specified for the promoted service or component service that is promoted:
java.property.weatherApp.invocationTimeoutInMilliseconds

For example, the following property sets the timeout value to 2 minutes:

java.property.weatherApp.invocationTimeoutInMilliseconds=12000

Summary: If a service provider and a service consumer exist in the same BPM
application, undeploying the application might undeploy the service provider even
though the service consumer still requires the service provider.

Workaround: Separate the service consumer and the service provider so that they
are both in two separate user applications.

Summary: You might not be able to start TIBCO® BPM Enterprise as a Windows
Service after upgrading to ActiveMatrix release 3.3.0 from release 3.1.5 (or previous
releases) or TIBCO® BPM Enterprise release 2.2.0 from release 2.1.0 (or previous
releases).

Workaround: If you encounter this issue:

1. Open a command prompt where tibcohost.exe is located.

2. Uninstall existing TIBCO® BPM Enterprise Windows service by running:

tibcohost.exe —--uninstall

3. Install the Windows service again by running:

tibcohost.exe --install

Summary: Acceptor threads for HTTP connectors might consume excessive amounts
of CPU. The processing performance of any node that uses an HTTP connector
experiencing this issue might be affected when asynchronous 10 is involved.
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Key

4013

AMR

3788

AMX-
19325

AMX-
19294

AMX-
19290

AMX-
19235

Summary

Workaround: Edit the HTTP Connector resource template to use blocking 10. For
more information, see the section "Managing Resource Templates" in T/BCO
ActiveMatrix Service Grid Administration.

Summary: The LDAP resource template pool properties are not used when initializing
the connection pool.

Workaround: Configuring the connection pool using system properties specified for
the target node applies them to all instances deployed to that node.

Refer to the Oracle documentation for more information:

http://docs.oracle.com/javase/jndi/tutorial/ldap/connect/config.html.

Summary: Logging configuration changes takes time to get effectively applied, as
compared with earlier BPM 4.3.2 version.

For Instance, if log appender level changed from Trace to Info, it takes 15-20 mins to
print respective level logs.

Note: This is observed for fresh BPM 433 setup as well as upgraded setup.
Workaround: None

Summary: After upgrading from older versions (3.3 or 3.4), the TIBCO Configuration
Tool still offers the option to configure the TIBCO Service Performance Manager
(SPM) dashboard. However, it's important to note that SPM functionality has been
removed and is no longer supported in AMX 3.4.2. End user is requested not to use
this option.

Workaround: None

Summary: SPM folder under AMX_Home/admin/amxadmin/samples path is
obsolete. Users are requested to refrain from referring the SPM folder as this feature
is removed and not supported any more from AMX 3.4.2

Workaround: None

Summary: When user apply logger at application level, logs do not print in the
appender file.
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Key

AMX-
19222

AMX-
19221

AMX-
19131

AMX-
19086

Summary

Workaround: After applying the logger at application level, re-start the respective
application.

Summary: Upgrading AMX 3.4.2 introduces a potential incompatibility with the
existing BPM 4.3.2 platform if it hasn't been upgraded to 4.3.3 which supports Java 11
as well. This mismatch in Java versions (Java 8 and Java 11) can cause an expected
behavior where applications within the BPM system (both system apps and user
apps) fail.

Workaround: Upgrade BPM 4.3.2 to 4.3.3 to resolve this expected behavior.
Summary: Upgrading AMX 3.4.2 introduces a potential incompatibility with the
existing BPM 4.3.2 platform if it hasn't been upgraded to 4.3.3 which supports log4j

2.x as well. This mismatch in log4j versions can cause an expected behavior where
applications within the BPM system (both system apps and user apps) fail.

Workaround: Upgrade BPM 4.3.2 to 4.3.3 to resolve this expected behavior.

Summary: Support for the TIBCO enabled JDBC driver for IBM DB2 4.32.28 is added
in TIBCO ActiveMatrix® Service Grid 3.4.2 but it is not visible in the TCT Third-party
Driver Configuration Wizard List.

Workaround:

1. Open a Third-party Driver Configuration Wizard from TCT.
2. Select TIBCO enabled JDBC driver for IBM DB2 4.24.92 Driver.

3. Download the latest JDBC Third-Party Driver Jar of DB2 11.5.x (Jar name:
db2jcc4.jar and Version: 4.32.28).

4. Give the path of the db2jcc4.jar folder in TCT and Configure.
Summary: After the successful upgrade from AMX330 HFx to AMX342, in the

SystemNode log, you see the following errors related to logservice, if you have
selected Deploy log service and monitoring service in AMX330:
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Key

AMX-
19018

AMX-
18994

AMX-
17525

Summary

1. [com.tibco.amx.commonlogging.logservice.app]
com.tibco.amx.cf.logger.lifecycle -
java.lang.IllegalStateException:
org.springframework.beans.factory.BeanCreationException

2. [com.tibco.amx.platform]
com.tibco.amx.it.webapp.WebAppImplementationAdapter - Exception
occurred during webApp un-deployment of component 'WTPLogService'
3. com.tibco.amx.cf.logger.lifecycle -
java.lang.NullPointerException: null at
com.tibco.governance.mcr.aggregator.runtime.core.GovernanceAggregat
or.registerExtensionPoint(GovernanceAggregator.java:567) ~[?:7?]

Workaround: None

Summary: Test Connection with SQL Server 2019 is failing with the following error
"sun.security.validator.ValidatorException: PKIX path building failed".

Workaround: To configure the third-party driver mssql-jdbc-11.2.3.jar for Microsoft
SQL Server 2019 or any backwards compatible Microsoft SQL Server database, you
must add trustServerCertificate=true in the JDBC URL.

Example JDBC URL:

jdbc:sqlserver://test-
localhost:1433;DatabaseName=dbname;trustServerCertificate=true

When you download the Microsoft JDBC Driver for SQL Server (version 11.2.3), the
default JAR name is mssql-jdbc-11.2.3.jre8, but when configuring the third-party
driver by using TCT, you must rename mssql-jdbc-11.2.3.jre8.jar to mssql-jdbc-
11.2.3.jar.

Summary: When AMX 3.3.0 HF27 with an Admin server configured with Deploy Log
Service and Deploy Monitoring Service is upgraded to AMX 3.4.2, JMS Appenders
appear on the Logging Appenders page.

Workaround: None

Summary: User applications with IT plug-in scenarios that contain the old javax.jms
version fails and displays the following error:
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AMX-
19068

AMX-
19087

Summary

Import-Package: javax.jms;version="[1.1.0,2.0.0)"

Workaround: Fix all instances of Import-Package error by upgrading
javax.jms;version="[1.1.0,2.0.0)" to javax.jms;version="[2.0.0,3.0.0)".

Summary: Moving the TLS (Transport Layer Security) Version 1.2 to TLS (Transport
Layer Security) Version 1.3. in the Admin SSL fails.

Workaround:

1. Go to this location:

<ConfigHome>\tibcohost\Admin-amxadmin-instanceOne\data_
3.2.x\host\plugins\ri_tibco.admin.default.ssl.server_
SystemNode_1.0_1686560749194.jar.

2. In the file ri_tibco.admin.default.ssl.server_SystemNode_1.0_
1686560749194.jar, change the TLS (Transport Layer Security) version
information from 1.2 to 1.3.

3. Save this file.
4, Restart the administrator.
5. Check if the admin SSL protocol is showing TLS (Transport Layer Security)

Version 1.3.

Summary: "LogService" and "PayloadService" applications are present under the
System Applications list on SystemEnvironment after upgrading AMX 3.3.0 HF27 to
AMX 3.4.2 and error is seen in the SystemNode log.

Workaround:

When upgrading from AMX 3.3.0 HF27 to AMX 3.4.2, do not select the Deploy Log
Service and Deploy Monitoring Service when creating an admin. However, if they
were selected while creating the admin, remove the "LogService" and
"Payloadservice" applications from the system applications explicitly from the GUI
and CLI.
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Key Summary
AMX-  Summary: Host node installation fails after upgrading fromTLS (Transport Layer
19078  Security) Version from 1.2 to TLS (Transport Layer Security) Version 1.3.

Workaround:

a. Go to this location:

<ConfigHome>\tibcohost\Admin-amxadmin-instanceOne\data_
3.2.x\host\plugins\ri_admin.default.jmx.ssl.sip_
SystemNode_.jar

b. Open sr_admin.default.jmx.ssl.sip_SystemNode.xml file and change the TLS
(Transport Layer Security) version information from 1.2 to 1.3.

c. Save this file.
d. Restart the administrator.

e. Create a host.

AMX- Summary: (Linux RHEL 9) For AMX 3.4.2, TCT fails and displays the following error.

19109
Error while loading shared libraries: libnsl.so.1l: cannot open
shared object file: No such file or directory.

Workaround: Install the libnsl package using the command:

$ sudo yum install libnsl

AMX-  Summary: Consider the following upgrade path:

18981
1. TIBCO ActiveMatrix Service Grid 3.3.0 (including hotfixes) with TIBCO

ActiveMatrix Binding Type for REST 3.3.0 (hotfix 005) is installed.
2. Upgrade to TIBCO ActiveMatrix Service Grid 3.4.0 (including hotfixes).
3. Upgrade to TIBCO ActiveMatrix Service Grid 3.4.1 hotfix 01.

4. Install TIBCO ActiveMatrix Service Grid 3.4.1 hotfix 02.
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AMX-
18980

Summary

5. Run Enterprise Deployment Health Check. The following fails on this setup.
Workaround:
1. Navigate to <TIBCO_HOME>/amx/3.4/bin and edit ant.tra.
2. Replace [[path.separator]] in tibco.class.path.extended with;

(Semicolon).

tibco.class.path.extended=%TIBCO_
HOME%/components/shared/1.0.0/plugins/com.tibco.tpcl.org.apache.too
ls.ant_1.9.9.001[[path.separator]]%TIBCO_
HOME%/tools/lib/antpackage.jar

Updated:

tibco.class.path.extended=%TIBCO_
HOME%/components/shared/1.0.0/plugins/com.tibco.tpcl.org.apache.to
ols.ant_1.9.9.001;%TIBCO_HOME%/tools/lib/antpackage.jar

Summary: After installing TIBCO ActiveMatrix Service Grid hotfix 02 in the replicated
Administrator setup, the following error is observed in the following scenario:

1. Create a runtime host and node.

2. Change the shared folder location by using the following command:

ant -f sharedWorkFolder_build.xml -Dadmin.shared.folder="<NEW
SHARED FOLDER LOCATION>" -Dconfig.home="<CONFIG_HOME>" -
Denterprise.name="<ENTERPRISE_NAME>"

The following error occurs:

[AMXAdminTask] 14 Mar 2023 01:52:31 ERROR - Resource Instance
Update failed

[AMXAdminTask] 14 Mar 2023 01:52:31 ERROR - TIBCO-AMX-CLI-
000343:

Install resource instance 'tibco.admin.default.keystore'
failed
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Key

AMX-
18884

AMX-
18872

AMX-
18646

AMX-
18583

Summary

Please see the cause for more details

Workaround: None.

Summary: After upgrading to TIBCO ActiveMatrix Service Grid 3.4.1, the
com.tibco.amx.bwse.application BWSE platform application is in the Stopped
state. Unable to deploy a BWSE application in the upgraded environment.

Workaround: None.
Summary: The "Authorization By Role" policy with access granted to

"AuthenticatedUsersOnly" does not work. Authentication fails with the error:
"Unauthorized Access" even after providing a correct username and password.

Workaround: None.

Summary: The following upgrade path fails:

Upgrade from ActiveMatrix Service Grid 3.1.5 to version 3.3.0 by using scripts. Then
upgrade from version 3.3.0 to version 3.4.0. Then upgrade from version 3.4.0 to
version 3.4.1.

Workaround:

e Before upgrading to ActiveMatrix Service Grid 3.4.1, update
java.heap.size.max=512M to java.heap.size.max=1024M in the <TIBCO_
HOME>/amx/3.4/bin/nodeutil.tra file.

 After performing the preceding step, upgrade to version 3.4.1 is successful but
some runtime host fails to start after upgrade and the
com.tibco.amx.platform.artifactserver application in the
SystemEnvironment is in the Start failed state.

In this case, manually start Host and Nodes OR undeploy and deploy the
com.tibco.amx.platform.artifactserver application.

Summary: After upgrading from an earlier version with ActiveMatrix Policy Director
Governance installed to ActiveMatrix Service Grid 3.4.1, the ActiveMatrix Policy
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Key

AMX-
18539

AMX-
18554

AMX-
18536

AMX-
18474

Summary

Director Governance application version is not displayed correctly in the
Administrator Ul.

Workaround: None. This issue does not have a functional impact. Everything works
as expected.

Summary: Downgrading from ActiveMatrix Service Grid 3.4.1 to an earlier version by
using TIBCO Configuration Tool in the silent mode fails with the following error:

java.lang.RuntimeException: XPathFactory#newInstance() failed to
create an XPathFactory for the default object model:
http://java.sun.com/jaxp/xpath/dom with the
XPathFactoryConfigurationException:
javax.xml.xpath.XPathFactoryConfigurationException:
java.util.ServiceConfigurationError: javax.xml.xpath.XPathFactory:

Workaround: None
Summary: TIBCO ActiveMatrix BusinessWorks™ Service Engine application
deployment fails after upgrade to ActiveMatrix Service Grid 3.4.1.

Workaround: None

Summary: When invoking an SSL enabled SOAP service, which refers to the keystore
file with DH key size <1024k, the following error occurs:

javax.net.ssl.SSLHandshakeException: DH ServerKeyExchange does not
comply to algorithm constraints

Workaround: Update your keystore to use the DH key size larger than 1024.

OR

Edit tibcojre64/1.8.0/1ib/security/java.security file and add the desired length
to the jdk.tls.disabledAlgorithms property by appending DH KeySize < min key
length:

jdk.tls.disabledAlgorithms=SSLv3, TLSvl, TLSv1l.1, RC4, DES,
MD5withRSA, \
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Key

AMX-
18365

AMX-
17606

AMX-
17411

Summary

DH keySize < 768

Summary: When secure SystemHost and RemoteHosts (host for which the JMX port
is secured) are successfully upgraded to ActiveMatrix Service Grid 3.4.1, the
Administrator Ul does not show the updated version of the hosts correctly.

Workaround: When the hosts are secured, SystemNode is configured with TLSv1,
which is the supported TLSv1 in versions of ActiveMatrix Service Grid prior to 3.4.0.
Starting from ActiveMatrix Service Grid 3.4.0 and later, TLS1.2 is supported, and all
the Hosts are updated to automatically use TLSv1.2 when upgraded to 3.4.1, except
the Administrator (SystemNode).

When you encounter this issue, run the following command after upgrading to
ActiveMatrix Service Grid 3.4.1 to update Administrator (SystemNode) to support
TLSv1.2.

Navigate to <TIBCO_HOME>/amx/3.4/bin folder and run the following command:

tibamx_hostmanager updateAdminToTLSv12 -configHomelLocation <TIBCO_
CONFIG_HOME>

Note:
e Hosts and nodes MUST be stopped before running the above command.
After running the command, restart Administrator (SystemNode).

* The preceding command must be run only on the machine where
SystemNode and SystemNodeReplica (if applicable) are running.

Summary: If you have upgraded from an earlier version of TIBCO ActiveMatrix
Service Grid including hotfixes to TIBCO ActiveMatrix Service Grid 3.4.0, when you
downgrade from TIBCO ActiveMatrix Service 3.4.0 to the earlier version, you cannot
revert the hotfixes applied earlier using the revertPatch command.

Workaround: None

Summary: When the java.property.com.tibco.amx.decouple.Manual.Nodes
property is set to true in the TRA file, the SystemHost is downgraded but the
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AMX-
17409

AMX-
17393

AMX-
17365

Summary

SystemNode fails to downgrade.

Workaround:

1. Set the following property:

java.property.com.tibco.amx.decouple.Manual.Nodes=false

2. Restart ActiveMatrix Administrator.

3. Upgrade SystemHost to 3.4.0 and downgrade again.

Summary: Consider that an ActiveMatrix Administrator server is upgraded to 3.4.0
from a prior version and this server is downgraded with a wrong ActiveMatrix
Administrator port. In this case, if you do not test the connection to the ActiveMatrix
Administrator server before the downgrade, the TIBCO Configuration Tool downgrade
process stops responding when checking ActiveMatrix Administrator initialization at
the "Checking for Admin initialization..." step.

Workaround: Stop the TIBCO Configuration Tool and provide correct information for
ActiveMatrix Administrator configuration. For example, port, SSL information. Run the
downgrade wizard again.

Summary: When the SAML Single Sign On configuration is enabled, if you delete the
browser cookies, after redirecting from the error page to the landing page, you are
not prompted for login credentials.

Workaround: Log out from the previous browser session.

Summary: After upgrading to ActiveMatrix 3.4.0, the ActiveMatrix 3.3.0 Hotfix<x>
runtime host fails to downgrade with the following error:

product feature
com.tibco.amf.sharedresource.extensions.runtime.tibcohost.product.f
eature 3.3.xx.000 contains a release unit
com.tibco.amf.hpa.core.runtime.services.feature 1.5.0.003 that does
not exist in the machine model

Workaround: Always select the Mediation Runtime option while installing the
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Key

AMX-
17351

AMX-
17343

AMX-
17323

AMX-
17316

AMX-

Summary
Runtime Host profile for the remote host.

Summary: Even after downgrading from 3.4.0 to a lower version and uninstalling
3.4.0, the Configure TIBCO Service Performance Manager - V2.3 option is available
in the TIBCO Configuration Tool. If you click the option, a Null Pointer Exception
occurs.

Workaround: None. Do not click the Configure TIBCO Service Performance
Manager - V2.3 option.

Summary: If one of the EMS servers fails on an Amazon Web Services (AWS) setup,
the status of some nodes is shown as LOST_Contact.

Workaround: Reconnect the EMS connections by clicking Admin Configuration >
Admin Server > Transport Configuration tab > Administrator Reconnect. After the
reconnection, all the entities are shown as online.

Summary: The TIBCO ActiveMatrix Governance Agent for TIBCO BusinessWorks
Notification screen of the Create TIBCO ActiveMatrix Policy Director
Administrator Server - V3.4 wizard is removed in 3.4.0. However, some shared
resources related to this screen (EMS ConnectionFactory, JMS Destination, JNDI
Connection) are created in ActiveMatrix Administrator. These shared resources are
added as an application property and can be viewed from the ActiveMatrix
Administrator Ul:

e Application name: com. tibco.ampd.ogp.de
e Properties: bwImsSharedResource and bwAgentAdapterJmsDestination
Workaround: The shared resources created by the screen are not used. You can

ignore them.

Summary: After the uninstallation of ActiveMatrix Service Grid 3.4.0, some files and
folders are not removed from TIBCO_HOME. For example, the tibamx_
hostmanager.properties file from the TIBCO_HOME/amx/3.4/scripts and TIBCO_
HOME/tct/1.6 directories is not removed.

Workaround: None

Summary: In the TIBCO Configuration Tool, host names or DNS names cannot have
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Key

17182

AMX-
17144

AMX-
17120

AMX-
16828

AMX-
16800

AMX-
16672

Summary

underscores in their names. As a result, TIBCO Configuration Tool fails if the name of
the Available Group Listener contains underscores while configuring the Alwayson
Database Setup in SQL Server 2017.

Workaround: Do not use underscores in the name of the Available Group Listener
while configuring the Alwayson Database Setup on SQL Server 2017.

Summary: On Microsoft Windows, when you try to update JRE by using the TIBCO
Configuration Tool, occasionally the following error occurs:

Caused by: TIBCO-AMX-TOOLS-JREUPDATER-000048: Cannot write to the
file. TIBCOHOME\amx\3.4\scripts\rpflauncher_classpath_3.4.0.tra.

Workaround: Run the command two or three times until it succeeds.

Summary: Occasionally, because of manual intervention or execution of certain
scripts, the network time of the machine where Active Directory Federation Services
(ADFS) or WebApp is hosted might be out of sync and result in an authentication
failure for a response being too old.

Workaround: The network time of the machine must be synchronized. For Linux, the
synchronization must happen with the Network Time Protocol server. For Windows,
use the Windows time service. There are standard operating system level procedures
for synchronizing the machine network time.

Summary: If you invoke a REST service binding with an OpenlID Policy through a
SOAP client such as SoapUl, it always sends an Access Token, which is an opaque
token. Access Tokens are not currently supported.

Workaround: Use the ID Token (which is a JWT token) generated by the Access
Token URI to send the request in SoapUl.

Summary: On a replication setup, when upgrading from 3.3.0 to 3.4.0, the primary
ActiveMatrix Administrator server does not start correctly after a successful upgrade.

Workaround: Restart the ActiveMatrix Administrator server.

Summary: Double downgrade is not supported. For example, downgrading from
3.4.0 to 3.3.1 to 3.3.0 fails with the following errors:
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AMX-
16634

AMX-
16542

AMX-
16505

AMX-
16083

AMX-
16016

AMX-
15975

Summary

TIBCO-AMX-CLI-000944: Failed to downgrade TIBCO Host instance(s).
TIBCO-AMX-CLI-000942: Downgrade TIBCO Host 1instance <instance name>
is not possible.

Workaround: None

Summary: For an upgraded TIBCO host, the tibcohost describeHost command
incorrectly shows the upgrade status as None.

Workaround: None

Summary: After upgrading TIBCO Business Studio to TIBCO ActiveMatrix 3.4.0, it is no
longer supported on the macOS operating system.

Workaround: None

Summary: On a replicated setup, if one of the servers is downgraded, the version of

the TIBCO ActiveMatrix REST BT Administrator Plug-in shows as 3.4.0 instead of
showing the previous version.

Workaround: None

Summary: If a Java project has errors (faults) configured in RRC and has an
execution environment as JAVASE-1.6 or lower, DAA generation fails.

Workaround: To generate the DAA file, make sure that the
RequiredExecutionEnvironment field in the Manifest.MF file is empty. It allows you
to create the DAA and deploy it at run time.

Summary: Downgrading the SystemHost from ActiveMatrix 3.4.0 to an earlier version
fails if the CONFIG_HOME where the SystemHost is present contains other runtime
hosts that are bound to a different ActiveMatrix Administrator server instead of the
ActiveMatrix Administrator server from the selected CONFIG_HOME.

Workaround: Ensure that all the runtime hosts that are in the selection CONFIG_HOME
must be bound to the ActiveMatrix Administrator Server from the CONFIG_HOME.

Summary: Even when the command-line interface is used, the notification transport
update fails with the following error message:
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AMX-
15840

AMX-
15806

AMX-
15775

AMX-
15756

AMX-
15614

Summary

TIBCO-AMX-ADMIN-021085: Failed to update the notification
transport!, Caused by:

TIBCO-AMX-ADMIN-021281: The number of hosts in this enterprise is more than 10.
Please use the Administrator Command Line Interface for updating
the Notification Transport.

Workaround: None

Summary: After upgrading from 3.2.0 to 3.4.0, the Mediation application template
shows the version as 3.4.0.007 instead of 3.5.0.007.

Workaround: None

Summary: When a DAA created in 3.3.0 with javax.servlet is run as a composite
application in 3.4.0 (Deployment Artifacts > right-click the DAA file > Debug As >
Composite application), RAD starts, but fails with provisioning Node errors.

Workaround: Re-create the DAA in 3.4.0.

Summary: In 3.4.0, an HTTP connector is created as non-blocking by default. That is,
the Use Non-Blocking 10 Sockets checkbox on the Advanced tab is selected by
default. When this checkbox is selected, the Acceptor Threads field on the General
tab is disabled and 1 is used as the default number of Acceptor Threads.

For an internal HTTP connector, if the Use Non-Blocking 10 Sockets checkbox is
cleared and a value greater than 1 is specified in the Acceptor Threads field, all
except one of the Acceptor Threads is in a blocked state.

Workaround: Keep the Use Non-Blocking 10 Sockets checkbox on the Advanced
tab cleared.

Summary: During installation using the GUI mode, a name cannot be specified for
the installation environment.

Workaround: Install using the silent installation mode if you want to specify an
environment name.

Summary: When creating an ActiveMatrix Administrator server by using TIBCO
Configuration Tool, if the Oracle username has quotes (¢ ») and hyphen (-), TIBCO
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AMX-

15569

AMX-
15261

Summary

Configuration Tool fails to create the ActiveMatrix Administrator server and returns
the following error:

Caused by: java.sql.SQLSyntaxErrorException: ORA-00942: table or
view does not exist

Workaround: Avoid using quotes (¢ ”) and hyphen (-) in the username.

Summary: The -ignoreNodeStartupMode argument of the Host Manager's
startAllHosts command does not work for a Microsoft Windows NT host. For a
Microsoft Windows NT host, it starts a node configured for automatic startup but
does not start a node configured for manual startup.

Workaround: Start a Microsoft Windows NT host or service manually.
Summary: On a machine that has a TIBCO ActiveMatrix 3.3.0 Hotfix installed, while

upgrading to TIBCO® BPM Enterprise 4.0.0, the TIBCO ActiveMatrix version is
downgraded if all the following options are selected:

» Upgrade ActiveMatrix TIBCO Host Instance
e Upgrade ActiveMatrix Administrator
» Upgrade Nodes Hosting TIBCO® BPM Enterprise Instance

» Upgrade TIBCO® BPM Enterprise Instance Application [Upgrading
Database]

Workaround:
1. Stop tibcohost.

Apply the TIBCO ActiveMatrix 3.3.0 Hotfix again by running the patch manager.

Start tibcohost.

> W

From ActiveMatrix Administrator, check Systemnode and bpmnode. The
expected hotfix version is displayed.

5. Open TIBCO Configuration Tool to upgrade to TIBCO® BPM Enterprise 4.0.0.
Select the last two options:

» Upgrade Nodes Hosting TIBCO® BPM Enterprise Instance
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AMX-
13851

AMX-
11970

BJMS-

Summary

e Upgrade TIBCO® BPM Enterprise Instance Application [Upgrading
Database]

Summary: If you use Microsoft SQL Server 2012 as an external database server and
use its Mirror Mode to establish a connection to a secondary fail-over database
server, TIBCO ActiveMatrix Administrator fails to connect to either database server.

Workaround In addition to providing the JDBC URL of the mirrored servers in SQL
Server 2012, you must set the IP and hostname of both the primary and secondary
database servers in the hosts file. The location of the host file depends on the
operating system:

e Windows: ROOT_DIR\system32\drivers\etc\hosts
e UNIX/Linux: /etc/hosts

For example, you have two database servers. The primary server's IP is 192.167.71.42
and its hostname is amx-db42. The secondary server's IP is 192.167.71.60 and its
hostname is amx-db60. You would provide the following JDBC URL for these two
mirrored primary and secondary servers:

jdbc:sqlserver://192.167.71.42:1433;databaseName=db1l;failoverPartne
r=192.167.71.60

To ensure that the ActiveMatrix Administrator successfully connects to both servers
and allows for seamless switching between them using SQL statements, you must
add the following entries to the host file:

192.167.71.42 amx-db42
192.167.71.60 amx-db60

Summary: In a replicated ActiveMatrix Administrator server setup, if you deploy to
the system node applications with policies applied on them, the policies are not
enforced after upgrade.

Workaround: First undeploy and then redeploy these applications after upgrading all
System Nodes.

Summary: JNDI Resource Template using Custom Property for LDAP Provider URL is
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1490

BJMS-
1382

BJMS-
1374

BJMS-
755

BJMS-
736

BJMS-
726

BJMS-
718

Summary

not installed.

Workaround: Provide a URL in the Provider URL field on the Resource Template.

Summary: If JMS Binding configured with JMS At Least Once Policy is undeployed
before the redelivery count is exhausted, and deployed again, the message is not
redelivered.

Workaround: None

Summary: If JMS Binding is configured with JMS At Least Once Policy and the EMS
Provider URL used for connection is fault tolerant, the message is not redelivered in
case the EMS crashes.

Workaround: None

Summary: Enterprise Message Service XA Resources from orphaned transactions do
not disappear after a transaction timeout from the Enterprise Message Service server.
They are seen on the Enterprise Message Service server as a part of the show
transactions command.

Workaround: Restart the Enterprise Message Service server. As there is no locking in
messaging associated with an XA resource, this issue is not serious.

Summary: When a 2.x project containing a JMS binding is migrated to 3.x, the JNDI
resource templates required for looking up the destination are not created and the
generated warning does not clearly state that JNDI resource templates need to be
created.

Workaround: Manually create JNDI resource templates required for defining inbound
and outbound destination configurations.

Summary: On restarting the Enterprise Message Service, for in-flight messages, the
transaction does not get committed. Redelivery happens and the message is
forwarded to the error queue.

Workaround: Recover the requests from the error queue.

Summary: For JMS binding, the SDS Ul allows you to set the context parameters of a
type message. This is not supported for JMS Binding.
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BJMS-
636

BJMS-
603

BJMS-
355

BJMS-
139

DSS-
982

Summary

Workaround: Do not use a type Message for Context Provisioning related to JMS
Binding.

Summary: The show connection command in the TIBCO Enterprise Message Service
administration tool ems-admin does not contain the "ClientID" value for connections
created by JMS resource instances for outbound connections.

Workaround: None

Summary: ActiveMatrix Administrator does not validate that an application with a
JMS Transacted One-Way Policy set should be deployed on a single node.
Workaround: Ensure that the JMS binding that has a JMS Transacted One-Way Policy

is deployed on the same node as that of one or more components it is wired to.

Summary: When a JMS service is deployed in LB setup over routed queues, the
following message is displayed and the service does not start:

javax.jms.IllegalStateException: Not allowed to use transacted
session on routed queues

Workaround: Enterprise Message Service does not support transactions on routed
queue consumers. Enterprise Message Service 6.0 added an explicit check to prevent
this. You can restore the old behavior by setting the following configuration
parameter:

allow_unsupported_tx_routed_q_consumers = true

Summary: If you rename an operation in a WSDL file, JMS bindings on composite
services and references are not updated correctly.

Workaround: Create a JMS binding after renaming the WSDL operation or reassign
the WSDL file to an existing JMS binding.

Summary: Changing or updating the TIBCO Credential Server (TCS) certificate results

in host security failure.

Workaround: None
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DSS-
813

HKA
M-452

HKA
M-442

HKA
M-441

Summary

Summary: While upgrading to ActiveMatrix release 3.3.0, you might see begin errors
similar to the following example:

[ERROR]com.tibco.trinity.runtime.base.provider.identity.CipherSuppo
rt

Workaround: Such errors are harmless and do not mean that the upgrade failed. No
action is required.

Summary: (Linux) AMXNode microagents are not loaded on the Hawk 7. x console.

Workaround: None.

Summary: Hawk Console does not display alerts for newly created Rulebase for the
below mentioned Node microagent methods.

a)getBindingInfo
b)getBindingOperationStats
c)getComponentOperationStats
d)onBindingOperationStats
e)onComponentOperationStats

Workaround:

1. Open hawkconsole.cfg and uncomment the property sql_schema_path.

2. Go the path on disk mentioned in the property sql_schema_path. For ex: <HAWK_
HOME>/<HAWK_CONFIG>/cfgmgmt/hawk/sql/

3. In this folder you will find 2 files data.sql and schema.sql. Open schema.sql and
update the table named "alert" and adjust the size of the column name which throws
an error from 28 to 768 -> data_index varchar(768).

4, Restart Hawk Console.

Summary: After the successful upgrade from AMX330 HF27 to AMX342, on Hawk
Console, invoking method changeMonitoringConfig() for microagents fails with the
following error.

"class java.lang.Integer cannot be cast to class java.lang.Long (java.lang.Integer and

TIBCO ActiveMatrix® Service Grid Release Notes



46 | Known Issues

Key

HKA
M-430

HKA
M-411

HKA
M-402

HKA
M-397

Summary

java.lang.Long are in module java.base of loader 'bootstrap')"

Workaround: Please refer to changeMonitoringConfig section in the Hawk
ActiveMatrix® Plug-in User’s Guide, to troubleshoot this issue.

Summary: Hawk Console fails to start after upgrading AMX 3.3.0 HF27 to AMX 3.4.2.

Workaround:

1. Inthe HAWK-HOME\hawk\7.1\lib from
HawkHome\hawk\7.1\lib\ext\console-ext file, replace the below-mentioned
jars with version 5.1.8 jars.

spring-beans.jar > spring-beans-5.1.8.RELEASE.jar
spring-context.jar > spring-context-5.1.8.RELEASE.jar
spring-core.jar > spring-core-5.1.8.RELEASE.jar

2. Finally, start tibhawkconsole.

Summary: On the Solaris operating system, the AMXNode microagents are not shown
in the Hawk Display.

Workaround: None

Summary: After upgrading ActiveMatrix 3.3.0 to ActiveMatrix 3.4.0, when you call the
getConfig method, the Monitoring Application State is shown as NOT CONFIGURED.

Workaround: Before upgrading to ActiveMatrix 3.4.0, apply ActiveMatrix 3.3.0 Hotfix
10 or higher.

Summary: When a Hawk ActiveMatrix Plug-in (HKAM) is used for large-scale systems,
tibhawkagent stops automatically with the following error:

RV: DrainQueue: out of memory.

Workaround: If HKAM is configured with more than 10 hosts, increase the memory of
tibhawkagent.

To change the memory of tibhawkagent:
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HKA
M-389

HKA
M-384

HKA
M-374

HKA
M-373

Summary

1. Open tibhawkagent.tra located at
<hawk.config.home>/tibco/cfgmgmt/hawk/bin.

2. Change values of -XX:MaxPermSize, java.heap.size.initial and
java.heap.size.max based on the number of hosts.

For 60 hosts, the following values are recommended:
e java.heap.size.max =4 GB
e —XX:MaxPermSize =1 GB
Summary: After a Notification Transport Server Configuration update, the

TIBCOHost's HKAM rulebases point to the previous Notification Transport Server
Configuration.

Workaround: After a Notification Transport Server Configuration update, you must
manually update the TIBCOHost's HKAM rulebases.

Summary: When HKAM is configured on a large-scale setup, invoking a method on a
host microagent fails with a timeout.

Workaround: Change the default HKAM rulebase for host and node. Make it event-
driven rather than polling at a fixed interval.

Summary: On Windows Server 2008 R2, if a node belongs to a host created with a
Windows NT service, invocation of the following methods on the node microagent
fails with a StatsDataAdapter is null error:

e changeMonitoringConfig
e getBindingOperationStats
e getComponentOperationStats

o getConfig

Workaround: None
Summary: When a QIN update is performed on a host, which is already configured

with HKAM, the EMS-related information in the hawkems<host_name>.hma file points
to the old notification server.
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HKA
M-343

HKA
M-337

HKA
M-336

HKA
M-266

HKA
M-264

Summary

Workaround: Change the EMS values for -user, -encryptedPassword, and -server
of the new notification server manually in the hawkems-<host_name>.hma file.

<arg>-user</arg>
<arg>S${new_username}</arg>
<arg>-encryptedPassword</arg>
<arg>${new_password}</arg>
<arg>-server</arg>
<arg>${new_notification_server_url}</arg>

Summary: On Solaris, hawk. log shows the following error and method invocation for
CLEventPublisherMicroAgent does not return any data:

Error loading microagent from
com.tibco.hawk.microagent.commonlogging.publisher.CLEventPublisherM
icroAgent: java.lang.IllegalArgumentException

Workaround: None

Summary: For a node, you cannot view statistics for a WebApp component using the
onComponentOperationStats Hawk method.

Workaround: None

Summary: For a node, you cannot view statistics for a WebApp component using the
getComponentOperationStats Hawk method.

Workaround: None

Summary: If the ActiveMatrix Administrator server or TibcoHost instance is

configured to use the SSL-enabled Enterprise Message Service on the AIX platform,
and Hawk 5.0 is installed, then starting Hawk Agent fails with an error.

Workaround: Use Hawk 4.9 instead of Hawk 5.0.

Summary: You cannot change the timeout of method invocation for a Custom
microagent.

Workaround: None
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HKA
M-253

HKA
M-251

HKA
M-250

HKA
M-249

HKA
M-242

HKA
M-237

HKA
M-193

Summary

Summary: Hawk Display shows multiple entries for node Service microagent when
rulebases for TibcoHost or nodes are invoked after the TibcoHost or node crash.

Workaround: Click Done, and open the microagent again. Alternatively, restart Hawk

Display.

Summary: Continuous error messages are seen in the hawk. log file after starting
tibhawkagent.exe on HAWK 5.0. Hawk 5.0 is unable to run powershell.exe used in
TibcoHost rulebase.

Workaround: Prefix powershell.exe in the rulebase of the TibcoHost with the
absolute path of powershell.exe.

Summary: When using Hawk 5.0, logs are not generated in the CONFIG_
HOME /hkam/<host_instance_name>/logs folder. The Hawk Agent shows errors related
to s1f4j in the Hawk logs.

Workaround: Remove the s1f4j jars and jars with different versions of s1f4j from
the agent classpath.

Summary: The Stop Reason and Reason Code arguments are not updated for the
onNodeEvent method after calling stopNode.

Workaround: None

Summary: Hawk 5.0 cannot find Windows PowerShell.

Workaround: Prefix powershell.exe in the rulebase of the TibcoHost with the
absolute path of powershell.exe.

Summary: On creating a node in the ActiveMatrix Administrator web interface, its
rulebase is created in the CONFIG_HOME/hkam/<host_instance_name>/rulebases
folder. If the node is deleted, the HAWK. log file continuously produces errors.

Workaround: Manually delete the rulebase to avoid error entries in the HAWK. log file.
Summary: Hawk ActiveMatrix Plug-in displays some ActiveMatrix applications or

components in runtime state as uninstalled, but ActiveMatrix Administrator or
nodeutil do not show these applications.
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IWAP-
725

IWAP-
669

IWAP-
223

IWAP-
72

Summary
Workaround: Restart Hawk Agent to clear the cache.

Summary: (TIBCO® BPM Enterprise only) If you change a substitution variable (such
as %%httpConnectorPort%%) from a hardcoded value (such as 443) or conversely in an
HTTP connector resource template, Workspace, and Openspace fail to open and you
might see an error similar to the following example in the logs:

[ERROR] com.tibco.n2.rtc.ap.ActionProcessor - [ERROR] - {WS_
REQUEST_EXCEPTION} - Workspace caught an Exception -
{extendedMessage="Invalid Security Context: Missing requested
attribute

Workaround: Redeploy the application and restart Workspace and Openspace.

Summary: If you add a WebApp component to an imported project created in
ActiveMatrix 3.2.0 that already has a WebApp component, every time you select the
newly added WebApp component after selecting the original WebApp component the
Thread Context Class Loader Type dropdown list in the Properties > Implementations
tab is disabled.

Workaround: Deselect the newly added WebApp component (by selecting any area
on the canvas that is not the original WebApp component from the imported project),
then select the newly added WebApp component again. The Thread Context Class
Loader Type dropdown list is enabled.

Summary: In the web.xml file, resource-ref elements are not supported.
Workaround: None

Summary: The WebApp component does not have an option to modify the Web

Application connector during deployment in TIBCO Administrator Ul.

Workaround: To configure or change the connector name in TIBCO ActiveMatrix
Administrator:

1. In TIBCO Business Studio, open the project containing the Web Application
component.

2. Promote the defaultConnector property to a composite level:
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a. Select the defaultConnector property on the component.
b. Right-click and select Promote.

Make the composite property a substitution variable so it can be substituted in
TIBCO Administrator before deployment.

Right-click on composite and select Create DAA.

In ActiveMatrix Administrator, make sure that a connector with the same name
is created in ActiveMatrix Administrator and deployed on to the node before
the Web Application DAA is deployed.

MCR-  Summary: If you have configured Microsoft SQL Server 2012 as a database for
2002 Administrator, invoking a custom DAA might result in harmless exceptions similar to
the following examples:

Caused by: com.microsoft.sqlserver.jdbc.SQLServerException:
Violation of UNIQUE KEY constraint "UQ__Mcr2Stat__
1C012A471DC5DDE4".

Cannot insert duplicate key in object 'dbo.Mcr2StatisticsMetric'.
The duplicate key value 1is (93, 21, 22, 3, -1).

at

com.microsoft.sqlserver.jdbc.SQLServerException.makeFromDatabaseErr
or (SQLServerException.java:216)

at

com.microsoft.sqlserver.jdbc.SQLServerStatement.getNextResult

(SQLServerStatement.java:1515)

at

com.microsoft.sqlserver.jdbc.SQLServerPreparedStatement.doExecutePr
eparedStatement SQLServerPreparedStatement.java:404)

Workaround: None

MCR-  Summary: If you have configured IBM DB2 as an external database, you might see
1995 harmless exceptions similar to the following examples in SystemNode. log:

Retrying database transaction after error: Processing of metric
requestsIn for event
com.tibco.governance.amxserviceprobe.ServiceProbeInstruments.Servic
eRequestIn failed for measure Total and time window Since Started

TIBCO ActiveMatrix® Service Grid Release Notes



52 | Known Issues

Key

MCR-
1943

MCR-
1823,

TAP-
10602

MCR-
1422

MCR-
1350

MCR-
1226

Summary

Time Window

Retrying database transaction after error: Processing of metric
faults for event
com.tibco.governance.amxserviceprobe.ServiceProbeInstruments.Servic
eExecutionTime failed for measure Total and time window Since
Started Time Window

Workaround: Such exceptions are benign and do not require any action.

Summary: If you have upgraded to ActiveMatrix release 3.3.0 from a prior version
and attempt to replicate the upgraded configuration, deploying the replicated
configuration might fail.

Workaround: Replicate your configuration before upgrading to ActiveMatrix release

3.3.0.

Summary: The value for the uptime displayed in the infrastructure dashboard
screens is accounted from the time a request is made to the application by invoking
the endpoint or through an internal call from another application.

If an application is deployed and not used, the value for uptime is 0.
Workaround: None

Summary: If nodes are restarted when the SystemNode is down, the Uptime and
Since Started statistics are not reset.

Workaround: Either make sure that the system node is running using admin

replication or restart the applications for which incorrect statistics are seen.

Summary: The number of components reported for a given node in the Enterprise
Graphical View includes components that belong to the ActiveMatrix Platform
Application. The Dashboard component count does not include these components.

Workaround: None
Summary: The Endpoint, Service, and References tabs display an incorrect value for

Avg Comp Process Time when extended monitoring is enabled. The value displayed
is Req Comp Time.
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MCR-
1205

MCR-
1204

MCR-
1162

MCR-
876

MCR-
800

Summary

Workaround: The correct average component processing time is available in the
Components and Applications tabs.

Summary: If the TibcoHost is shut down while the dashboard is running, the
following error message is seen in the SystemNode log files:

[ERROR] org.apache.axis2.engine.AxisEngine -
bean:name=govObjFilterServiceMBean

Workaround: None. This error can be safely ignored.

Summary: Stopping the TibcoHost instance occasionally causes exceptions to be
generated in the log file. During a graceful stop of TibcoHost instance there might be
some exceptions in the log file with the root cause. For example:

Caused by: java.lang.RuntimeException: Statistics aggregator -1s
closing down, rolling back transaction

Workaround: Ignore the error.

Summary: Statistics for Web application components are not displayed in the
dashboard.

Workaround: None

Summary: The status value is Unknown and uptime is empty when the same
application is deployed on two nodes across environments.

Workaround: Change the application name during deployment. The application
name must be unique for an enterprise. The dashboard shows the correct status and
uptime.

Summary: When a component reference is promoted, component reference metrics
show zero values. All metrics are shown on the promoted reference and reference
endpoint.

Workaround: View the metrics on the promoted reference.
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MCR-
753

MCR-
521

MED-
3306

MED-
2907,

MED-
2885

MED-
2055

MED-
1827

Summary

Summary: In the Dashboards > Infrastructure screens the application request count
includes request counts from all services promoted to application level. In addition, it
incorrectly includes the reference invocations count from all references promoted to
application level.

Workaround: None
Summary: If a node is stopped or started several times while SystemNode is down,

the last stop or start time of SystemNode is used to calculate the node’s uptime
percentage. Other stops and starts are missed and not used in uptime calculation.

Workaround: Configure the ActiveMatrix Administrator server in fault tolerant mode.

Summary: SOA projects created by the AutoMediate Tool might fail to be deployed
by the tool if the projects have SOAP over JMS bindings.

Workaround: Re-create all JMS Connection Factory and Destination resources in
TIBCO Business Studio.

Summary: The Mediation editor does not reload changes to the XSD unless the
project is restarted.

Workaround: To resolve this:
1. Import all projects into the workspace.

2. Restart TIBCO Business Studio.

3. Run Project > Clean > Clean all projects.

Summary: The Transform task does not handle the Byte Order Mark (BOM) in
external style sheet files.

Workaround: Open the style sheet in a text editor and save it manually in a format
without using BOM.

Summary: Deploying a mediation application that uses custom XPath functions and
if the custom XPath function plug-in is not deployed, results in errors at the time of
deployment.

Workaround: None
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MED-
1739

MED-
1736

MED-
1703

MED-
1652

PD-
4479

PD-
4429

PD-
4435

Summary

Summary: When adding a PortType with many (about 50+) operations, the validation
begins before the mediation flow is fully updated. This causes error markers to
appear on the mediation operations when no actual problems exist.

Workaround: Select Project > Clear from the menu bar and the validation restarts.

The error markers disappear unless there are actual problems that remain.

Summary: Dragging and dropping a WDSL into a mediation flow results in the
following error:

Receive Wrong Transfer data

Workaround: None

Summary: Creating schema using the Create button creates the schema for the CMT
model plug-in wizard but does not set it.

Workaround: Once the schema is created, you can browse and select the schema in

the wizard to set it for both Input and Output Schemas in the plug-in wizard.

Summary: The message type context property does not specify an unbound message
even though the selection list contains all message elements in the WSDL. An
unbound message is one that is not used for Input, Output, or fault parts.

Workaround: Only select unbound message elements for context properties.
Summary: Even after successfully downgrading from 3.4.x (example: 3.4.0 or 3.4.1) to

ActiveMatrix 3.3.0 (with Hotfix 23 and Policy Director Hotfix 02 installed), the
following plug-ins show 3.4.x as the version:

e TIBCO ActiveMatrix Operations Governance Platform Administrator plug-in
e TIBCO ActiveMatrix Administrator Governance Policy Director Admin plug-in
Workaround: This issue does not have a functional impact. Everything works as

expected.

Summary: When the Basic or User nameToken Authentication Governance Control is
enforced on the object group with a WebApp and REST binding member, the policy
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PD-
4431

PD-
4423

PD-
4420

PD-
4371

PER-
1931

Summary

does not work when used as User nameToken Authentication but works when used
as Basic Authentication.

Workaround: None

Summary: A policy is not enforced for an application if the application is deployed
before deploying the Policy Director Governance server.

Workaround: None

Summary: Logging policy is not supported by the ActiveMatrix Administrator server

(with ActiveMatrix Policy Director Governance services) of ActiveMatrix 3.4.0 when the
server is configured with the SSL-enabled Enterprise Message Service.

Workaround: None
Summary: On the Governance tab of the ActiveMatrix Administrator Ul, the

applications that have policies applied to them incorrectly show their undeployed
policies as Active.

Workaround: None
Summary: OpenlD Connect authentication is not supported by Policy Director

Governance in this release. Consequently, the following operation in TIBCO
ActiveMatrix Administrator fails:

Governance > New > Authentication By OpenID

Workaround: None
Summary: Nonce is not supported for messages sent from TIBCO ActiveMatrix
BusinessWorks to TIBCO® BPM Enterprise. Therefore, if you use TIBCO ActiveMatrix

BusinessWorks as a client to invoke an TIBCO® BPM Enterprise process as service, you
might see the following error:

PolicyEnforcement Failed to Authenticate the request.

Workaround: Modify the WSDL generated by ActiveMatrix to add the following
schema, WSDL message, and WSDL input in binding to successfully invoke an TIBCO®
BPM Enterprise service from TIBCO ActiveMatrix BusinessWorks.
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Summary

Schema

<xsd:schema elementFormDefault="qualified"
targetNamespace="http://schemas.xmlsoap.org/ws/2002/07/secext">
<xsd:import
namespace="http://schemas.xmlsoap.org/ws/2002/07/utility"/>
<xsd:element name="Security" type="s2:Security"/> <xsd:complexType
name="Security">

<xsd:sequence>

<xsd:element minOccurs="0" maxOccurs="1" name="UsernameToken"
type="s2:UsernameToken" />

</xsd:sequence>

</xsd:complexType>

<xsd:complexType name="UsernameToken'>

<xsd:sequence>

<xsd:element minOccurs="0" maxOccurs="1" name="Username"
type="xsd:string"/>

<xsd:element minOccurs="0" maxOccurs="1" name="Password"
type="xsd:string"/>

</xsd:sequence>

</xsd:complexType>

</xsd:schema>

WSDL Message

<wsdl:message name="PUTSecurity">
<wsdl:part name="Security" element="s2:Security"/>
</wsdl:message>

WSDL Input in Binding

<soap:header message="tnsl:PUTSecurity" part="Security"
use="T11iteral"/>

For example:

<wsdl:binding name="ProcessPackageProcess_EP"
type="tnsl:ProcessPackageProcess'">
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PER-
714

PER-
632

PER-
609,

PER-
623

Summary

<soap:binding style="rpc"
transport="http://schemas.xmlsoap.org/soap/http"/>
<wsdl:operation name="CatchMessageEvent'">
<wsdl:documentation/>

<soap:operation style="rpc" soapAction="CatchMessageEvent" />
<wsdl:input>

<soap:header message="tnsl:PUTSecurity" part="Security"
use="T11iteral"/>

<soap:body use="T1literal" parts="inl"/>

</wsdl:input>

<wsdl:output>

<soap:body use="Tliteral" parts="outl"/>

</wsdl:output>

</wsdl:operation>

</wsdl:binding>

<soap:header message="tnsl:PUTSecurity" part="Security"
use="T11iteral"/>

Summary: Multiple SOAP references deployed in a single node that are sending
different credentials to a single SOAP service protected with the Basic Authentication
Policy could result in erroneous authentication failures for some of the references
even if they are sending valid credentials.

Workaround: You can either:

e Deploy these references in different nodes

e Configure these references with different HTTP client resource instance
configurations

Summary: For proper policy enforcement, every composite containing a web
application component must have a different context root.

Workaround: None

Summary: The UsernameTokenAuthentication and WSSProvider are incompatible
policies. These policies have redundant functionality, but they cannot co-exist on the
same SOAP service.

UsernameTokenAuthentication authenticates using only the username token in the
WS-Security header.
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PER-
583

PER-

557

PER-
49

RSBT-
784

Summary

WSSProvider authenticates using any available information in the WS-Security
header.

Both policies remove the WS-Security header from the message after successful
authentication. If both policies are in effect at the same service, when the first one
(wssSProvider) succeeds, the second (UsernameTokenAuthentication) must fail,
because the WS-Security header is no longer available. This failure causes request
messages with proper credentials to fail erroneously.

Workaround: Do not apply the policies WSSProvider and
UsernameTokenAuthentication together at the same SOAP service.

Summary: For bundled policies added in this release, if one or more resource
instances used in the policy is reinstalled, policy enforcement fails.
Workaround: Redeploy the application after reinstalling one or more resource
instances.

Summary: The policy AuthorizationByRole does not support nested groups.

Suppose user A is a member of group B, which is a subgroup of group C. If group C
has access permission to request an operation, and user A attempts to request that
operation, then the request fails. That is, members of group B do not inherit access
permission from group C.

Workaround: Configure access permissions directly in each subgroup (in this

example, in group B).

Summary: When configuring an LDAP Authentication resource template in
Administrator, the option to generate SAML 1.1 assertion is not supported by
platform policies.

Workaround: When configuring an LDAP Authentication resource template, accept
the default setting to generate SAML 2.0 tokens.

Summary: Open ID authentication is not supported when invoking REST Service
Bindings using the Swagger Ul. Only basic authentication is supported.

Workaround: None
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Key

RSBT-
779

RSBT-
721

RSBT-
719

RSBT-
716

RSBT-
603

Summary

Summary: For a REST binding, when using the POSTMAN REST client, the basic or
username token authentication policy is not enforced if you do not provide
authentication.

Workaround: None

Summary: In the Swagger Ul, if SSL is enabled over a REST binding that uses the self-
signed certificate and you send a request over HTTP, it returns the following error:

TypeError: Failed to fetch

Workaround: Add the certificate as an exception in the browser.

Summary: In Swagger Ul, on selecting a parameter content-type as
application/bjson, the schema is not populated with the correct BJSON format.

Workaround: You can manually form the request payload of type Badgerfish (
JSONapplication/bjson) to get a proper response.

Summary: To test an endpoint, when you select the request content-type as
application/xml, an XML request payload is generated in the Swagger Ul. The
payload does not include the namespace for the elements that are defined in an
imported XSD, that is, the namespace is not pre-populated in the payload.

Workaround: Manually provide a namespace for such elements.

Summary: When the Java property
com.tibco.amf.runtime.bindingtype.rest.extendedJsonConversion is set to true
for a runtime node in the REST Resource Configuration (.RRC) file for a reference
binding, and if the POST request contains a JSON array with exactly one JSON
element in it (as specified below), the JSON array is treated as a single, non-array
element. This results in a NullPointerException at runtime when multiple elements
are sent as part of the request.

Erroneous usage:

{"addRequestOperation": {"Arrays":[{"Key":"keyl", "Value":
"valuel"}]}}
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RSBT-
408

RSBT-
398

RSBT-
391

RSBT-
382

RSBT-
371

Summary

Workaround: In the RRC file, specify multiple elements in the JSON Array element as
follows:

Correct usage:

{"addRequestOperation": {"Arrays":[{"Key":"keyl", "Value":
"valuel"}, {"Key":"key2", "Value": "value2"}]}}

With this change, the Array object is treated as a JSON array at runtime and the
NullPointerException is not seen.

Summary: A Null Pointer Exception is produced when a Pass Through Mode sample
project is deployed in RAD.

Workaround: Deploy the project in ActiveMatrix Administrator.

Summary: A REST service binding is updated after an operation is added to a WSDL.

Workaround: None

Summary: After renaming an RRC file through the Process Explorer, the name of the
file is updated in the reference > Bindings tab > Rest Resource Configuration File
link.

Workaround: None

Summary: If the RRC file name begins with xm1, an error is occurred while generating
the Java implementation.

Workaround: None

Summary: When a context parameter is added or edited, the following message is
displayed at the promoted reference:

Regenerated context parameter mappings

When you click the message, the mappings are created but the error message does
not disappear.

Workaround: Clean the project.
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RSBT-
368

RSBT-
363

RSBT-
358

RSBT-
346

RSBT-
231

Summary

Summary: In the RRC file, if an operation name begins with a "/", an exception is
produced.

Workaround: None

Summary: While creating a REST binding on a promoted service, clicking Next does
not result in any action.
Workaround: Click Finish.

Summary: The following data types in a generated XSD do not match the data types
in the JSON payload:

=

unsignedByte mapped to short
nonpositiveinteger mapped to float
nonnegativeinteger mapped to float
unsignedshort mapped to int

gYear mapped to short
negativeinteger mapped to float

unsignedlong mapped to float

o N o 00 A~ W N

positiveinteger mapped to float
9. boolean mapped to string
Workaround: Manually edit the XSD file to reflect the correct datatypes.

Summary: Error messages for duplicate resource names or operation names are not
displayed immediately when configuring a REST resource configuration (.rrc) file.
Similarly, the error message does not go away automatically when the duplicate
resource names or operation names are removed.

Workaround: Perform a clean operation.

Summary: While adding a binding, when the pass through mode is enabled, a note
or warning indicating that any existing WSDL on the component reference is replaced
by the pass through WSDL is not displayed.

Workaround: None
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RSBT-
230

RSBT-
58

SDS-
7890

SDS-
7880

SDS-
7799

SDS-
7781

SDS-

Summary

Summary: The HTTP Client textbox is not cleaned up after the resource template is
deleted from the Resource Templates folder.

Workaround: None

Summary: If you upload a DAA that includes a REST binding, ActiveMatrix
Administrator does not check whether HTTP connector resource instances exist for
HTTP connectors defined for the REST binding. Later, when you attempt to deploy
this DAA, the deployment fails because of the missing resource instance.

Workaround: Create an HTTP connector resource instance in the ActiveMatrix
Administrator GUI. While configuring the REST binding in TIBCO Business Studio, the
name of the resource instance must match the user-specified HTTP connector name.

Summary: While regenerating the Java implementation in Studio, if you change the
port type or service operation, a Null Pointer Exception is raised.

Workaround: A Null Pointer Exception is raised because this is related to the
WSDL created in previous versions of Studio. Rebuild the projects after regenerating
the WSDL from the studio.

Summary: SOA service application with Java component referred in mediation
application fails when upgraded from 3.4.2 SDS.

Workaround: Select update, re-provision and resolve check box if you are upgrading
from SDS. Alternatively, undeloy and deploy the application again, it will reflect the
updated application version.

Summary: While generating a command-line script, if you add a new server, a Null
Pointer Exception is produced.

Workaround: After adding a new server, click on the Refresh button.
Summary: After you successfully migrate SOA projects from ActiveMatrix 2.x to

ActiveMatrix 3.4.0 in TIBCO Business Studio, WS_Samples of 2.x result in
implementation errors.

Workaround: None

Summary: After you successfully migrate SOA projects from ActiveMatrix 2.x to
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7780

SDS-
7779

SDS-
7776

SDS-
7763

SDS-
7729

Summary

ActiveMatrix 3.4.0 in TIBCO Business Studio, DAA generation fails for the
EmployeeVacation (2.x) Sample project.

Workaround: None

Summary: After you successfully migrate SOA projects from ActiveMatrix 2.x to
ActiveMatrix 3.4.0 in TIBCO Business Studio, SoapException 2.x sample project results
in implementation errors.

Workaround: None

Summary: After importing a 3.1.5 or 3.2.0 Java sample project in 3.4.0 TIBCO
Business Studio, the following error is displayed:

JAR file dincompatible with JRE/JIDK 1.7 due to containing entries
with the empty name.

Workaround:
1. Open the Problems view.

2. Look for instances of the following error message:

JAR file incompatible with JRE/JDK 1.7 due to containing
entries with empty name.

One such message is generated for each offending JAR file.

3. Right-click all these messages and select a quick fix to apply.

Summary: When you open TIBCO Business Studio in a new workspace and click Help
> Search for the first time, a NullPointer exception is returned.

Workaround: None

Summary: While running Ant files in TIBCO Business Studio, the following error is
returned :

Launching <projectName><ant.deployment-build.xml' has encountered a
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SDS-
7725

SDS-
7685

SDS-
7680

Summary

problem,
Launch configuration <projectName><ant.deployment-build.xml
references non-existing project <projectName>

This is because of a bug in the Eclipse platform 4.7.1a
(https://bugs.eclipse.org/bugs/show_bug.cgi?id=522581).

Workaround: Run the Ant file using the Run in the same JRE as the workspace

option in the Create, manage, and run configurations dialog. Alternatively, change the
project containing the build.xml to a Java project by adding
<nature>org.eclipse.jdt.core.javanature</nature> to the list of <natures> in the
.project file and then restart Eclipse.

Summary: If the 3.4.0 TIBCO Business Studio is used to load a workspace that has
been created using 3.3.0 TIBCO Business Studio, running RAD (Rapid Application
Deployment) fails with the following error because the 3.3.0 workspace contains JRE
1.7 information:

Unsupported minor version

Workaround: Change the workspace JRE to Java 1.8.

Summary: If a Java project uses the Java 8 specific syntax in the code, the DAA file
cannot be generated with an execution environment as JavaSE-1.8. However, Java 8
syntax and compilation is supported.

Workaround: To generate the DAA file with Java 8 code, make sure the
RequiredExecutionEnvironment field in the Manifest.MF file is empty. This allows
you to create the DAA and deploy it at run time.

» For a newly created project, the RequiredExecutionEnvironment field in the
Manifest.MF file is empty.

e For an existing project, if Java 8 specific code is added, remove the
RequiredExecutionEnvironment entry in the Manifest.MF file.

Summary: For a Custom Mediation task, generation of the DAA fails.
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SDS-
7669

SDS-
7640

SDS-
6729,

SDS-
6992

Summary

Workaround: While creating the Custom Mediation task, make sure the
RequiredExecutionEnvironment field in the Manifest.MF file is empty. This allows
you to create the DAA and deploy it at runtime.

Summary: In the ActiveMatrix Administrator CLI, upgrading the existing application
did not update the Contact and Description fields in DAA.
Workaround: In the SystemNode. tra file, set the following property:

java.property.com.tibco.amx.admin.application.update.description.co
ntact.during.upgrade=true

Summary: When an existing project is imported into a workspace and Java 8 code is
added to it, the following error is returned while creating the DAA:

Exporting bundles failed

Workaround: To generate the DAA file with Java 8 code, make sure the
RequiredExecutionEnvironment field in the Manifest.MF file is empty. This allows
you to create the DAA and deploy it at runtime.

Summary: ActiveMatrix projects created in versions prior to 3.2.0 that use Java,
Spring, or WebApp components encounter a Null Pointer Exception (NPE) dialog
when imported into any ActiveMatrix version running on JRE 1.7 or later. This is
caused by the incompatibility of JRE 1.7 with the JAR format of the DataBinding JARs
generated by ActiveMatrix versions prior to 3.3.0. This may happen if you have
upgraded to JRE 1.7 or installed an ActiveMatrix version that includes JRE 1.7, such
as version 3.3.0.

Workaround:

1. Open the Problems view.

2. Look for instances of the following error message:

JAR file 1dincompatible with JRE/JDK 1.7 due to containing entries with empty
name.
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SDS-
6264

SDS-
5866

SDS-
3890

Summary

One such message is generated for each offending JAR file.

3. Right-click on one of these messages and select a quick fix to apply. There are
three quick fixes available (all three back up old JARs):

* Fix JAR for JRE/JDK 1.7 compatibility-This option fixes only the selected
JAR (that is, the JAR you clicked to apply the quick fix).

 Fix all library JARs in project for JRE/JDK 1.7 compatibility-This option
fixes all of the offending JARs in the same project as the selected JAR
(that is, the JAR you clicked to apply the quick fix).

 Fix all library JARs in workspace for JRE/JDK 1.7 compatibility-This
option fixes all of the offending JARs in the workspace.

4. After applying a quick fix, some errors related to the component class may still
be seen. To clean up these errors, select the project that has the errors and
select Project > Clean.

Summary: If the Web Application component is added by right-clicking composite,
the Generated Servlet Implementation option is not available under the Quick Fixes
option.

Workaround: Select the Web Application component, right-click, and select Generate
Servlet Implementation.

Summary: When one of the nodes participating in a high availability configuration is

stopped and an application is deployed via TIBCO Business Studio, the deployment
never completes.

Workaround: Deploy the application from ActiveMatrix Administrator. The application
state is in a partially running state instead of running - which is the expected
behavior.

Summary: Sometimes, the following message is returned in the error log:

Unbanded EventlLoop Exception

Workaround: None. Ignore the error.
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SVCP-
84

TAP-
16208

TAP-
16364

TAP-
16046

TAP-
16045

Summary

Summary: The TIBCO ActiveMatrix Service Performance probe on the Administrator
node does not receive self-shutdown notifications sent from TibcoHost. This occurs
because the Service Performance Manager probe component on the Administrator
node responsible for such communication shuts down before it can send the
notification.

Workaround: None

Summary: The action history of a System Resource Instance, which is installed on
SystemNode shows the username as “null”. However, the action history of a System
Resource Instance, which is installed on Devnode shows the username as 'root'.

Workaround: None

Summary: If resource template used by application is updated from CLI, checking
resource template details from the Applications tab does not display new changes.

Workaround: Refresh the browser and then check the resource template details.

Summary: After deploying application with OpenID Authentication policy, If OpenID
Authentication resource template is updated in between, then accessing OpenID
application Redirect URI fails with the following error:

Failed to get connection. Exception: ManagedConnection pool has
been destroyed

Workaround: Redeploy the application or restart the node.
Summary: After deploying application with SAML SSO Web Profile Authentication

Policy, If SAML SSO Web Profile Authentication resource template is updated in
between, then accessing application Redirect URI fails with the following error:

Failed to get connection. Exception: ManagedConnection pool has
been destroyed

Workaround: Redeploy the application or restart the node.
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TAP-
16041

TAP-
15885

TAP-
15842

TAP-
15834

TAP-
15833

Summary

Summary: In the deploy-application target of application_build.xml file, if the
force attribute is set to true, then application deployment is successful even if the
required resource instance is not available. This issue is applicable if the resource
instance required for an application is defined in the policy set.

Workaround: When deploying an application, set the force attribute to false in the
deploy-application target of application_build.xml file. Setting the force
attribute to false checks for all dependencies required by an application.

Summary: Accessing ActiveMatrix Administrator Dashboards ( Dashboard >
Infrastructure) results in the following error:

Dashboard Bundle not Available. Please reload the browser.
TypeError: Cannot read
property 'Container' of undefined

Workaround: Access ActiveMatrix Administrator Dashboards using the procedure
mentioned in "Accessing Administrator Dashboards" section of the TIBCO ActiveMatrix
Service Grid Administration guide.

Summary: If you create an enterprise that uses a messaging bus and then create an
environment that does not use the messaging bus, the Configure enterprise without
a messaging bus checkbox on the Admin Configuration > General tab is disabled.

Workaround: None
Summary: When using the Microsoft Edge browser, when creating an Object Group of
Policy Director Governance by specifying the search criteria to find the matched

group members, if you click the + button to build the search criteria, the attribute
and operator dropdowns are not populated with the correct values.

Workaround: None
Summary: When using the Microsoft Edge browser, when building the search criteria

to find the matched group members, the X button does not clear the dropdown
boxes used to specify the search criteria.

Workaround: None
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TAP-
15827

TAP-
15822

TAP-
15817

TAP-
15664

TAP-
15645

Summary

Summary: If you have upgraded to ActiveMatrix 3.4.0, and then created a Host or
Node, some default loggers are missing on the newly created Host or Node.

Workaround: Before creating the Host, copy the
DefaultLogConfiguration.properties file on every TibcoHost instance on which the
ActiveMatrix Administrator server is running.

Copy the file from <TIBCO_HOME>\administrator\3.4\templates\ and paste it into
<CONFIG_HOME>\admin\amxadmin\private\<instanceName>\.

Summary: You cannot deploy an ActiveMatrix 3.4.0 DAA on ActiveMatrix 3.3.1
Administrator, ActiveMatrix 3.3.0 Administrator or ActiveMatrix 3.3.0 Hotfix 23
Administrator that uses Java 8.

Workaround: None

Summary: When using the Microsoft Edge browser on Windows 10, the Metrics
Collection Runtime dashboard is not displayed.

Workaround: None

Summary: On Solaris Sparc, Get Admin Information test of Enterprise Deployment
Health Check fails with the following error:

Couldn't obtain phys addr

Workaround: None

Summary: When a TIBCO ActiveMatrix enterprise has customized system host and
system node names (for example: SystemNodel, SystemNode2, or AdminNode) and
the system node does not fully start in a TIBCO ActiveMatrix enterprise. The following

error message is displayed on the TIBCO ActiveMatrix Administrator web page:

404 page not found
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TAP-
15563

TAP-
15523

TAP-
15503

TAP-
15488

Summary

Note: Prior to TIBCO ActiveMatrix 3.3.0 Hotfix 13, when a user tried to access a
TIBCO ActiveMatrix Administrator web page while it was still loading or the user
specified a wrong URL (but with correct IP address and port number), a "404 page
not found" HTTP error response was returned. Starting with TIBCO ActiveMatrix
3.3.0 Hotfix 13, in the same situation, a new 404 page is displayed. This new 404
page automatically redirects the user to the login page once TIBCO ActiveMatrix
Administrator is fully initialized and ready for service. However, this feature
applies only to environments where the System Nodes use the default node
names, that is, SystemNode and SystemNodeReplica. For System Nodes with
customized node names, the old behavior ("404 page not found" error page)
remains.

Workaround: Periodically, refresh the ActiveMatrix Administrator web page to
determine whether ActiveMatrix Administrator was completely initialized and is ready
for service.

Summary: After upgrading ActiveMatrix Administrator from 3.1.5 to 3.4.0, you can
start or stop a host from the ActiveMatrix Administrator GUI. However, 3.1.5 hosts
that are not upgraded yet, cannot be started or stopped from the ActiveMatrix
Administrator GUI.

Workaround: Start or stop the host by using the tibcohost command.
Summary: TIBCO ActiveMatrix Administrator > Infrastructure > Health Check page

does not open in Internet Explorer. However, it displays a link to open the page in a
new tab.

Workaround: Open http://localhost:8120/amxadministrator/amxmonitor.jspin a

new tab to view the Health Check page.

Summary: In the Google Chrome browser, when creating an Object Group of Policy
Director Governance by specifying the search criteria to find the matched group
members, if you click the + button to build the criteria, the attribute dropdown box
is not populated with the correct values.

Workaround: None

Summary: In TIBCO ActiveMatrix Administrator, some description fields do not work
with Chrome 66.0.3359.139 or higher versions.
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TAP-
15420

TAP-
15060

TAP-
14874

TAP-
14772

TAP-
14766

Summary
Workaround: None

Summary: In TIBCO ActiveMatrix Administrator, when you navigate to the
Infrastructure > Enterprise Status > Application tab and click Download Logs, the
requested application logs are not downloaded and the following error is displayed:

Cause: java.util.concurrent.TimeoutException.

Workaround: None

Summary: After successfully downgrading to a previous version, you must uninstall
the higher version.

Workaround: None

Summary: After reconnecting to EMS, ActiveMatrix Administrator shows the correct
status but the Action History continues to show "In Progress(n)".

Workaround: None

Summary: Even when the Notification transport update was completed successfully
using the ActiveMatrix Administrator CLI, the following error message was displayed:

TIBCO-AMX-ADMIN-021085: Failed to update the notification
transport!, Caused by:

TIBCO-AMX-ADMIN-021281: The number of hosts in this enterprise is
more than 10.

Please use the Administrator Command Line Interface for updating
the Notification Transport.

Workaround: None

Summary: Ideally, in TIBCO ActiveMatrix, you should update the Notification
Transport for all TIBCOHosts in the enterprise. If a particular TIBCOHost has to be
updated using the hosts option from ActiveMatrix Administrator CLI, you must
update the SystemHost's Notification Transport first, and then proceed with updating
the Notification Transport for other TIBCOHosts.
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TAP-
14699

TAP-
14242

TAP-
14052

TAP-
13994

TAP-
13942

Summary

If SystemHost is not updated first, while updating Remote TIBCOHosts, ActiveMatrix
Administrator CLI might show the update as having been completed successfully, but
the TIBCOHosts might not be updated.

Workaround: Update the Notification Transport for the SystemHost first.
Summary: When the Java property
java.property.com.tibco.amx.decouple.Manual.Nodes is not set to true in the

tibcohost. tra file, the status of a Manual Node is marked as Stopped even when it
is running (Node process remains in task manager).

Workaround: None
Summary: When you log in to ActiveMatrix Administrator server using SSL-enabled

LDAP authentication realm, return a non-fatal ClassNotFoundException in the
SystemNode log.

Workaround: None
Summary: The uninstall action does not work as expected with a wildcard if the

given feature versions have strict (1.0.0) and qualified strict (1.0.0.01) versions
together.

In a wildcard behavior, the following behavior is observed:

If the user has two versions for the same featureld in the form of 1.0.0 (Strict version
without qualifier) and 1.0.0.001 (Strict version with qualifier), precedence is given to
1.0.0.001 only and 1.0.0 is not uninstalled.

Workaround: To uninstall 1.0.0 explicitly, perform the same action again.
Summary: The Hostname in the Management URL of a TibcoHost instance gets

replaced with the Hostname of its source TibcoHost, when TibcoHost Instance is
installed successfully.

Workaround: None
Summary: On the <Host> -> <Resourcelnstance> page and Shared Objects ->

Resource Templates -> Resource Instances tab, environment or duplicate node
information is not displayed.
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TAP-
13910

TAP-
13828

TAP-
13777

TAP-
13696

TAP-
12878

Summary

Workaround: On the Details pane of <Host> -> <Resourcelnstance> page and Shared
Objects > Resource Templates > Resource Instances tab, navigate to the tree view
in the left side pane. This tree view provides the exact node name: <Environment
Name>_<node name>.

Summary: While exporting Logging Appenders, one logging appender <CustomName>_
Root is exported when the following conditions are met:

e The host name of the replicated admin server is changed from the default
SystemHostReplica to a custom name.

e Include System Objects option is NOT selected.

Workaround: None

Summary: When installing or uninstalling a node, the most recent state of the node
is displayed in the Action History column and not in the Node State column. For
example, after uninstalling a node, the Node State is Not Installed while the action
is in progress. This happens when there are incomplete tasks for action, but the node
state has already changed.

Workaround: Refer to the most recent state displayed in the Action History column
instead of the Node State column.

Summary: If the TibcoHost name in the ActiveMatrix Administrator GUI and run time
is different and the TibcoHost name from the ActiveMatrix Administrator GUI is
specified in the CLI data, the install/start/uninstall actions fail.

Workaround: None

Summary: If a Management URL is unreachable and you try to unregister the
TibcoHost, a warning message about the unreachable URL is not displayed.

Workaround: None

Summary: If you import a resource template into an upgraded user application that
did not previously contain a resource template (that is, if no resource templates had
previously been imported into the application), the scope of the imported resource
template is automatically set to Global, rather than Application. This occurs even if
you specify the Application scope in the CLI.
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TAP-
12860

TAP-
12858

Summary

Workaround: After the resource template is imported (to Global scope), change its
scope as required (to Application scope, for example) in the ActiveMatrix
Administrator Ul. To do this:

1. Go to Shared Objects > Resource Templates.
2. Select the imported resource template.

3. Click Change Scope, and change the scope to the Application or Environment
level as required.

Summary: If you have a main process and a subprocess application and one or more
dependent main process applications deployed in ActiveMatrix version 3.1.5 (and any
TIBCO® BPM Enterprise version between 1.3.0 and 2.1.0), then upgrade the BPM
platform version to TIBCO® BPM Enterprise 2.2.0 (ActiveMatrix 3.3.0), and
subsequently attempt to upgrade the subprocess, you see a warning similar to the
following example:

TIBCO-AMX-ADMIN-012430: Provided capability
'com.example.my.subprocess.pe.capability' provided by component
'MySubAppProcessFlow' cannot be removed. It is being used by the
following components:Component 'MyMainAppProcessFlow' from
application 'com.example.my.mainapp.process

This warning is issued erroneously and can be safely ignored. The subprocess is
upgraded successfully and the main processes runs as expected, provided the
subprocess maintains the same major version number as before.

Workaround: None

Summary: The logging configuration of a node, host, or application (which is stored
in the node, host, or application’s log4j.xml. For example, node-log4j.xml) might
enter into an inconsistent state if the node, host, or application uses a JMS appender
that is configured with an SSL-enabled EMS server. In this case, the logging
configuration uses an HTTP URL to refer to a keystore that is hosted on the
Administrator. This HTTP URL is the internal HTTP connector URL of the
Administrator.

Changing the configuration of the internal HTTP connector (for example, to enable
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TAP-
12714

TAP-
12702

TAP-
12319

Summary

SSL or change the port number) causes the URL configured in the logging
configuration (log4j.xml) to become invalid or out of sync. The logging configuration
of each affected node, host, or application needs to be updated or it fails to connect
to EMS. Currently this is not done automatically.

Workaround: You must manually save and apply the logging configuration for each
node, host, or application that uses a JMS appender. To do this:

1. In the ActiveMatrix Administrator Ul, go to the logging configuration for the
node, host, or application that is in the situation described above.

2. Change a value in the logging configuration that makes the node, host, or
application go out of sync. Then, click Save.

3. To push the new logging configuration with a new HTTP URL to the node, host,
or application, click Apply.

Summary: ActiveMatrix Administrator does not properly undeploy applications with
missing feature dependencies.

Workaround: To avoid this issue, go to Node > Configuration > Features and
remove the feature with Marked for Install and a blank value for Type.

Summary: If you use the TIBCO Configuration Tool to edit the ActiveMatrix
Administrator database settings, the following harmless error might appear in
SystemNode. log:

Could not open Hibernate Session for transaction.

Workaround: None

Summary: When deploying an application, ActiveMatrix Administrator automatically
installs resource instances if there are resource templates with scope to the
application. If the resource template installation fails, then application deployment
also fails. For example, if the HTTP connector has a port conflict, it fails to start.

Workaround: For HTTP connector port conflicts, use substitution variables to assign
different port numbers for each node to avoid port conflicts. Then uninstall the
application and redeploy it.
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TAP-
12087

TAP-
10830

TAP-
10800

Summary

Summary: Making changes to the configuration of a JDBC service resource template
that is a dependency for a running application might cause that application to enter
a Stopped state.

Workaround: Manually restart the stopped application.

Summary: When wiring a reference to a service in the same application that has a
SOAP binding using an HTTP Connector that does not exist results in the following
exception:

Error generating the WSDL for binding SOAPService_Bindingl, Caused
by: Could not find resource instance with name httpConnector when
generating WSDL for binding SOAPService_Bindingl on service
NewService

Workaround: Create the HTTP connector before creating the application.

Summary: When creating an Administrator server with an Oracle database the
following error messages are seen in the SystemNode log files:

SystemNode 30 Jul 2012 16:42:48,287 [WAR-Deployer-Thread] [ERROR]
org.hibernate.tool.hbm2ddl.SchemaUpdate - Unsuccessful: create
index AdmnCnfig_sttsNtifictinTrnsprt on "ADMINCONFIG"
("NTFCTNTRNSPRT_STTSNTFCTNTRNS_D")

SystemNode 30 Jul 2012 16:42:48,287 [WAR-Deployer-Thread] [ERROR]
org.hibernate.tool.hbm2ddl.SchemaUpdate - ORA-00955: name is
already used by an existing object

SystemNode 30 Jul 2012 16:42:48,303 [WAR-Deployer-Thread] [ERROR]
org.hibernate.tool.hbm2ddl.SchemaUpdate - Unsuccessful: create
index AMXdminsrPrfrncs_prvisnvslctin on "AMXADMINUSERPREFERENCES"
("PRVISNVSLCTIN_PRVISNVSLCTIN_ID")

SystemNode 30 Jul 2012 16:42:48,303 [WAR-Deployer-Thread] [ERROR]
org.hibernate.tool.hbm2ddl.SchemaUpdate - ORA-00955: name is
already used by an existing object

SystemNode 30 Jul 2012 16:42:48,319 [WAR-Deployer-Thread] [ERROR]
org.hibernate.tool.hbm2ddl.SchemaUpdate - Unsuccessful: create
index ApplicationFolder_childFolders on "APPLICATIONFOLDER"
("APPLICATIONFOLDER_PARENT_E_ID")

SystemNode 30 Jul 2012 16:42:48,319 [WAR-Deployer-Thread] [ERROR]
org.hibernate.tool.hbm2ddl.SchemaUpdate - ORA-01408: such column
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Key

TAP-
10767

TAP-
10751

TAP-
10663

Summary

list already -indexed

Workaround: These errors can be safely ignored as the indexes are created.

Summary: HTTP Connector resource instances that are referenced by properties
whose names are not specific, such as HttpInboundConnectionConfig or
httpConnector, are not recognized by Administrator as HTTP Connectors while
displaying information. As a result these HTTP Connectors are not displayed in the
Administrator Ul as dependencies were expected.

Also, you can delete any such HTTP Connector even when it has dependent
applications.

Workaround: Use property names such as HttplnboundConnectionConfig or
httpConnect to refer to HTTP Connectors resource instances. Additionally, when
deleting HTTP Connector resource instances, manually check whether other
applications are dependent on it.

Summary: Running the scripts generated by the DDL Script Generator for Microsoft
SQL Server displays errors reporting a failure to create foreign key constraints.

Also, even if the generated scripts are not used, error messages are seen in the
SystemNode log file logged in SystemNode. log regarding failure to create foreign key
constraints.

Workaround: None. These errors can be ignored as a failure to create foreign key
constraints that do not impact product functionality.

Summary: Heterogeneous environments with mixed JREs are not supported. Sun JRE
is not compatible with IBM JRE when it comes to storing secret keys in a Java
keystore. This causes a problem when the server running on Sun JRE stores a
username and password in its global identity keystore and a host and node running
on IBM JRE attempts to access that username and password. The reverse,
Administrator JRE would have the same problem.

Workaround: Ensure that, TibcoHost instances, and nodes are all using JREs
provided by the same vendor.
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Key

TAP-
7644

TAP-
7571

TAP-
7423

TAP-
6584

TAP-
5653

TAP-
4890

TAP-
4645

Summary

Summary: You might see the following error message when undeploying an
application:

[ERROR] com.tibco.amf.admin.server.axis2.RPCMessageReceiver -
Error occurred in Administrator... about to throw AxisFault for
this exception

Workaround: Refresh the browser. This error message can be safely ignored.

Summary: Users who have permissions only to view an application and an
environment but do not have permissions to view a node are not able to see the list
of selected nodes when distributing an application.

Workaround: Permissions to view the node have to be explicitly granted by a
superuser.

Summary: You might see errors in dashboard dialog box when using the Dashboard.

Workaround: Click OK to proceed using the Dashboard. This error message can be
safely ignored.

Summary: When the extended monitoring is enabled, the two new periodic Windows
(24 hours and 7 days) do not show on some Dashboard tabs.

Workaround: Refresh the browser.

Summary: Updating the value of a substitution variable for the Timeout property in a
JMS or SOAP/JMS binding in a deployed application does not take effect after the
application is redeployed.

Workaround: Undeploy and deploy the application.

Summary: In the dashboards, a text filter is ignored when you maximize or minimize
a gadget.

Workaround: Reenter the text filter.

Summary: On the Dashboards > Infrastructure screens, resource instances cannot
be filtered by promoted reference or promoted service.
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Key

TOO

1895

WSB

1149

WSB

1134

WSB

Summary

Workaround: In the Application Screen, check the properties of the reference or
service bindings.

Summary: If you update JRE by using the TIBCO Configuration Tool, the
TIBCOConfigurationTool.ini and TIBCOBusinessStudio.ini files are not updated
with new JRE HOME. Because of this, launching TIBCO Configuration Tool and TIBCO
ActiveMatrix Business Studio fails.

Workaround: None

Summary: Web service reliable messaging does not work in TIBCO ActiveMatrix
Service Grid 3.4.0.

Workaround: None

Summary: In the case of SOAP bindings, context parameters of Type "Message" can
be defined using "Message/Part" from the WSDL used by the binding. These message
context parameters can be used for declared unbound SOAP headers. The body of a
SOAP message is also defined using "Message/Part" configuration from the WSDL
used by the binding. Using the same "Message/Part" configuration for the SOAP
header and the SOAP body results in incorrect behavior while generating the SOAP
message, that is, either the <Header> or the <Body> element might be empty. This
applies to SOAP request, SOAP response and SOAP fault messages.

For example, if the body of the SOAP response is configured with
Message="GetSOAPResponse" /Part = "paraml" in the WSDL and the context
parameter of Type "Message" is defined with the same Message/Part Definition
"GetSOAPResponse/paraml”, the generated SOAP response message might contain an
empty <Header> or <Body> element.

Workaround: None. However, if distinct "Message/Part" pairs are used for SOAP
header and body, this issue does not occur. For example, if the body of the SOAP
response is configured with Message="GetSOAPResponse" /Part = "paraml" in the
WSDL and the context parameter of Type "Message" is defined with Message/Part
Definition "GetSOAPHeader/headerparaml", the generated SOAP response message
contains both <Header> and <Body> elements.

Summary: For SOAP bindings containing all in-only operations, the Enable Response
Message Validation field in ActiveMatrix Administrator and TIBCO Business Studio is
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Key

T-
1112,

WSB

1117

WSB
T-888

WSB
T-881

XPD-
5331

Summary

not applicable.

Workaround: At present, this field is not disabled for SOAP bindings containing all in-
only operations and, if selected, does not have any effect.

Summary: Substitution Variables are not available for all the fields in SOAP Service
and Reference Bindings. On the Service side, Substitution Variables are supported for
the following fields:

e Enable Request Message Validation
» Enable Response Message Validation
e Sender Identified Expression
On the Reference side, Substitution Variables are supported for the following fields:
e Enable Request Message Validation
* Enable Response Message Validation
e Filespec of Endpoint URL
Workaround: None
Summary: Policies and policy sets cannot be added, edited, or deleted via the

ActiveMatrix Administrator Ul. Policy-set properties can be viewed but not added,
edited, or deleted.

Workaround: Edit policy sets and properties in TIBCO Business Studio.
Summary: Deploying DAAs or applications with the following characteristics in

TIBCO® BPM Enterprise 2.2.0 runtime might result in a No request message is
found to add the user name token error at runtime:

» The DAA or application was created in TIBCO Business Studio prior to version
3.6.0.

e The DAA or application contains a Web Service invocation (that is, the
application is a consumer).

e The application has a User nameToken policy type in its security.
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Key Summary

Workaround: Open the project in TIBCO Business Studio 3.6.0, build the DAA, and
upgrade the existing application.

XPD- Summary: When you open a native file browse dialog on RedHat Linux for the first
1858 time, it crashes.

Workaround: Type the path to the file in the text control.
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TIBCO Documentation and Support Services

For information about this product, you can read the documentation, contact TIBCO
Support, and join TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the Product Documentation website,
mainly in HTML and PDF formats.

The Product Documentation website is updated frequently and is more current than any
other documentation included with the product.

Product-Specific Documentation

The documentation for this product is available on the TIBCO ActiveMatrix® Service Grid
Product Documentation page.

How to Contact Support for TIBCO Products

You can contact the Support team in the following ways:

e To access the Support Knowledge Base and getting personalized content about
products you are interested in, visit our product Support website.

e To create a Support case, you must have a valid maintenance or support contract
with a Cloud Software Group entity. You also need a username and password to log
in to the product Support website. If you do not have a username, you can request
one by clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee
subject matter experts to share and access their collective experience. TIBCO Community
offers access to Q&A forums, product wikis, and best practices. It also offers access to
extensions, adapters, solution accelerators, and tools that extend and enable customers to
gain full value from TIBCO products. In addition, users can submit and vote on feature
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requests from within the TIBCO Ideas Portal. For a free registration, go to
TIBCO Community.
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Legal and Third-Party Notices

SOME CLOUD SOFTWARE GROUP, INC. (“CLOUD SG”) SOFTWARE AND CLOUD SERVICES EMBED,
BUNDLE, OR OTHERWISE INCLUDE OTHER SOFTWARE, INCLUDING OTHER CLOUD SG SOFTWARE
(COLLECTIVELY, “INCLUDED SOFTWARE”). USE OF INCLUDED SOFTWARE IS SOLELY TO ENABLE THE
FUNCTIONALITY (OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED CLOUD SG
SOFTWARE AND/OR CLOUD SERVICES. THE INCLUDED SOFTWARE IS NOT LICENSED TO BE USED OR
ACCESSED BY ANY OTHER CLOUD SG SOFTWARE AND/OR CLOUD SERVICES OR FOR ANY OTHER
PURPOSE.

USE OF CLOUD SG SOFTWARE AND CLOUD SERVICES IS SUBJECT TO THE TERMS AND CONDITIONS
OF AN AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED AGREEMENT, OR, IF THERE IS NO
SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER AGREEMENT WHICH IS DISPLAYED WHEN
ACCESSING, DOWNLOADING, OR INSTALLING THE SOFTWARE OR CLOUD SERVICES (AND WHICH IS
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH LICENSE AGREEMENT OR CLICKWRAP
END USER AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE
OF THIS DOCUMENT IS SUBJECT TO THOSE SAME TERMS AND CONDITIONS, AND YOUR USE HEREOF
SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of Cloud Software
Group, Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, ActiveMatrix, Business Studio, Enterprise Message Service,
and Hawk are either registered trademarks or trademarks of Cloud Software Group, Inc. in the United
States and/or other countries.

All other product and company names and marks mentioned in this document are the property of
their respective owners and are mentioned for identification purposes only. You acknowledge that all
rights to these third party marks are the exclusive property of their respective owners. Please refer to
Cloud SG’s Third Party Trademark Notices (https://www.cloud.com/legal) for more information.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which is
available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

Cloud SG software may be available on multiple operating systems. However, not all operating
system platforms for a specific software version are released at the same time. See the “readme” file
for the availability of a specific version of Cloud SG software on a specific operating system platform.
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THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED
IN NEW EDITIONS OF THIS DOCUMENT. CLOUD SG MAY MAKE IMPROVEMENTS AND/OR CHANGES IN
THE PRODUCT(S), THE PROGRAM(S), AND/OR THE SERVICES DESCRIBED IN THIS DOCUMENT AT ANY
TIME WITHOUT NOTICE.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY RELEASE NOTES AND "README" FILES.

This and other products of Cloud SG may be covered by registered patents. For details, please refer
to the Virtual Patent Marking document located at https://www.tibco.com/patents.

Copyright © 2010-2024. Cloud Software Group, Inc. All Rights Reserved.
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